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About This Guide 

The purpose of this guide is to help you install and run Constellation III 
software for Macintosh computers on your Omninet Network. The guide is 
arranged as follows: 

• Chapter 1 is a brief introduction describing what hardware and 
software you will need, and defining the terms that are used. 

• Chapter 2 describes the characteristics of the different volume 
types, and gives you the information needed to effectively plan 
your network. 

• Chapter 3 describes the steps necessary for connecting and setting 
up hardware. 

II Chapter 4 details the steps in setting up the initial Network 
Manager and public volumes. 

1.1 Chapter 5 provides instructions for the routine tasks of network 
management, such as adding and deleting users and volumes, 
checking stats, and changing user or volume attributes. 

11 Chapter 6 tells you how to set up printing on your network. 

II Chapter 7 is aimed at the user of the network, and explains how to 
carry out routine tasks on the system. 

iii Chapter 8 describes how to use Constellation Ill's diagnostic 
utilities. 

If you are upgrading an existing Constellation III for Macintosh network to 
Release 2.0, please refer to Appendix A. 

To further clarify the instructions, informational and cautionary notes have 
been added. Watch for the icons. 

~ indicates an informational note. 
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~ indicates a cautionary note. 

It is assumed that you are setting up (or upgrading) a Corvus Network using 
one or more OmniDrives and Macintosh computers, and that you are 
familiar with how to use a Macintosh. If concepts such as dragging, 
clicking, and pulling down menus are new to you, refer to your Macintosh 
manual. 

Before You Get Started 

COpy DISKETTES 

The first thing you must do is make backup copies of the Constellation III 
software. You do not need a special disk copy program to copy them; this 
software is not electronically copy-protected, although copyright restrictions 
do apply. 

Store the master copy of all three diskettes in a safe place. Use the copies 
to install or upgrade your network. 

MINIMUM HARDWARE REQUIREMENTS 

In order to install and create a network, you need at least the following 
hardware: 

• 512K Macintosh 
• Corvus OmniDri ve 
• Corvus Omninet network cabling 
• Corvus Transporter Network Interface Card for each Macintosh 
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MINIMUM SOFTWARE REQUIREMENTS 

In order to install and create a network, you need the following software: 

From Corvus Constellation III (Release 2.0) software: 

• Network Manager Diskette 
• User's Diskette 
• Diagnostics 

From Apple the latest versions of the following files: 

• System (3.2 or later) 
• Finder (5.3 or later) 
• Font DjA Mover 
• Hard Disk 20 (for non-Enhanced, non-Mac Plus Macintoshes) 

These versions of System, Finder, and Hard Disk 20 can be found on the 
Corvus Diagnostic diskette 

KEY TERMINOLOGY AND PROGRAM NAMES 

Device Booting 

File Transfer 

Logoff 

Introduction 

Device booting eliminates the logon process of entering 
a name and password; in other words, a user might 
want to be able to turn on his Macintosh, insert a 
Startup diskette, and boot up without entering a user 
name or password. This feature is especially useful if 
you want to set up a Macintosh in a public place so 
that several people can share the computer. 

The File Transfer program allows users who do not 
have the same volume mounted to transfer files among 
themselves within a network. The program is 
especially useful for exchanging information between 
users with different computer types. 

The Logoff program unlocks any locked volumes, 
unmounts any mounted volumes, ejects floppy diskettes, 
and reboots the machine. This program should be run 
at the end of the day to close and update all volumes. 
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Logon The Logon program allows a user to log on to the 
network. 

Mount Manager Mount Manager is used to access and display volumes 
on the Macintosh desktop ("mount" on the desktop) and 
put back volumes ("unmount" from the desktop), as well 
as control the number of volumes mounted on the 
desktop (the maximum is six Constellation volumes) at 
one time. It can also be used to create a special file 
that will automatically mount specified volumes when 
a user logs on ("boots up") to the network. 

Network Manager The Network Manager is the person who implements 
and maintains the network system. It is also the name 
of one of the primary programs in Cons tell a ti6n III. 
The Network Manager program (found on the Corvus 
Mgr Diskette) is used primarily to create, delete, and 
change attributes for volumes and users. 

Pipes 

System file 

1-6 

There are three display modes in the program: Users, 
Volumes, and Drives. The modes are shown by pulling 
down the View menu. 

In the Volume mode, the Network Manager can create 
new vol urnes, delete old vol urnes, and modify existing 
ones. 

The Users mode allows a Network Manager to add new 
users, delete old ones, and print out lists of current 
users. 

The Drives mode is for selecting OmniDri ves on the 
network. 

Pipes is a program that allows you to view files that 
are in the queue to be despooled to a printer or 
transferred to another user on the network. 

The System file controls many of your system 
functions. See your Macintosh manual for further 
information on this file. 
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System folder 

System volume 

In trod uction 

Constella tion III for the Macintosh 

The System folder contains the System file and the 
Finder. In order to install or upgrade' your network, 
you will have to copy files from the new Corvus 
diskettes into the System folder. 

Your System volume is the volume displayed in the 
upper right-hand corner of your desktop after you 
have logged on. It should be the only volume mounted 
on the desktop with a System folder in it. If you have 
System folders in any volumes besides your System 
volume, delete them; these extra folders can cause 
serious network problems. 
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Planning for Constellation III 

Constellation III allows you to tailor your system to your particular needs. 
So, before setting up the network, you should consider how it will be used. 
For instance, if most of the users on your network will be running 
multiuser applications programs, you may want to add more uncontrolled 
volumes than you would if your users were working on individual private 
files. This chapter provides you with the basic information needed to plan 
an Omninet network. In order to plan a network effectively, you have to 
understand users and volumes. 

Users 

When setting up a network, you first need to determine who will be using it. 
Each person who will use the network needs a User Name (and, if desired, a 
User Password). The User Name can have a maximum of ten characters and 
the User Password can have a maximum of eight. Each user will need a 
Startup diskette to log on to the system, and a System volume. 

Volumes 

A Corvus network is built around an OmniDrive network hard disk server. 
The OmniDrive can hold the equivalent of tens to hundreds of regular 
Macintosh diskettes. Corvus divides this hard disk into units called 
volumes. 

Volumes are much like diskettes except that volumes can hold anywhere 
from half a diskette to forty diskettes' worth of data. Standard volumes 
range in capacity from one to eight diskettes, but you can also create 
custom volumes. 
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Volumes and diskettes are both represented by icons on the 'Macintosh 
desktop. The volume icon is a representation of the OmniDrive. Mounting a 
volume gives you access to that volume. When you mount a volume, the 
volume icon appears on the Macintosh desktop. The computer can then read 
and write data to and from that volume, unless the volume is locked or the 
access is con trolled. 

When planning volumes, there are three main considerations: the volume 
type, the volume attributes, and the volume access. The contents of a 
volume will usually dictate the volume access type and size. For shared 
programs, you will create either a public or controlled volume, unless you 
use multiuser applications programs, in which case you would need an 
uncontrolled volume. If you plan to share a printer on the network, you 
will also need to create a special volume called the Pipes volume. 

VOLUME TYPES 

In order to plan the exact kinds of volumes you need for your network, you 
need to understand the various types. There are four types of volumes, each 
serving a different purpose on the network. The four types are private, 
public, controlled, and uncontrolled. They differ in the way that users are 
allowed to access the information within a volume. For any of the four 
types, you may specify a password for added security. 

Once you have created volumes, use them instead of diskettes to improve 
the speed and efficiency of your operations. Copy all your files to the 
volumes and use diskettes only to log on or keep backup copies of files. 

The four volume types are explained below. 

Private Volumes. A private volume can be mounted and accessed only by 
its owner. The volume owner always has read-write access to his own 
private volumes, but he can choose to have read-only access if he wants to 
be certain that nothing in the volume will be modified or deleted. Every 
user will need to have his own private System volume. 

Public Volumes. Public volumes are for data and programs that users can 
share. The Network Manager should place the Mount Manager, File 
Transfer, Pipes, and Logoff programs in the same public volume. Everyone 
can then share them without using up space on their own volumes. 
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Only the owner of a public volume has read-write access and can actually 
change the volume's contents. Other users who know the password have 
only read-only access; they can open applications and documents in the 
vol ume, but they cannot make changes to them. 

Controlled Volumes. Controlled volumes should contain files that you want 
users to be able to update. Information in a controlled volume can be added 
to or modified by selected users on the network from their workstations. 

Controlled volumes are set up so that the first user to mount a controlled 
volume has read-write access to it. Other users who mount the volume later 
have only read-only access until the first user unmounts the volume. Then 
someone else is free to mount the volume with read-write access. 

Uncontrolled Volumes. Uncontrolled volumes allow all users who have the 
volume mounted to read and write data at the same time. If you have 
multiuser applications programs, then you will need to put them in 
uncontrolled volumes. However, if application programs that are not 
specifically designed for simultaneous use by multiple users are put in 
uncontrolled volumes, unrestricted read-write access could result in loss of 
data. 

You should not create an uncontrolled volume unless you 
have a specific multiuser application to use with it, and 
you should not put a System folder with System files in 
an uncontrolled volume. 

VOLUME ATTRIBUTES 

Some of the volumes on your network may be used by more than one person. 
The Constellation III network software has certain features that prevent 
users from interfering with each other's work. There are five features, 
called attributes, for each volume: owner, password, type, size, and 
opera ting system. 

All five attributes are specified when a volume is created. As the Network 
Manager, it is your responsibility to create volumes and assign them a 
volume owner. 

The volume password provides the second level of control for volume access. 
If a volume is protected with a password, only users who know the password 
can mount that volume. 
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Volume size is the third attribute. Volumes can be either small, medium, 
large or extra-large in size; their size should be determined by the amount 
of information they are expected to hold. 

Volume type is the fourth attribute you will specify for any volume you 
create. Being able to select from different types of volumes gives you 
another level of control over your volumes. 

Operating system is the last volume attribute. You can specify whatever 
operating system you want the volume to work under. In most cases this 
will be Macintosh. 

ACCESS TYPES 

Corvus volumes allow two different types of access: read-only (RIO) and 
read-write (R/W). When a volume can only be opened (or read, but its 
information not changed), its access is read-only (RIO). Read-only access is 
comparable to locking a diskette with the lock tab. 

When information in a volume can be changed the volume has read-write 
(R/W) access. 

The following table shows how access correlates with volume type. 

Access Volume Type 

Private Public Controlled Uncontrolled 

RIW Owner Owner First User to All Users 
Only Only Mount Volume 

RIO Owner All Users All Users All Users 
Only 
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CREATING VOLUMES 

The standard volume sizes are 800 (small), 1600 (medium), 3200 (large), and 
6400 (extra large) blocks. The Network Manager should determine the size 
of the volumes created by their anticipated uses. 

Blocks 

kb/MB 

Small 

804 
400kb 

Medium 

1604 
800kb 

Large Extra-Large 

3204 6404 
1.6MB 3.2MB 

The Network Manager should create a System volume for each user. This 
volume is typically a private volume and contains both the user's System 
folder and his private files. It is also a good idea for the Network Manager 
to create a public volume containing the Mount Manager, File Transfer, 
Logon, and Logoff programs. This way, all network users can share the 
Corvus utilities. For himself, the Network Manager should create a private 
System volume with all the latest Corvus software, any application 
programs, and the System folder. 

Finally, make a list all of the applications programs, documents, folders, 
and any other information that needs to be shared. 
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The chart below illustrates the way that users, volume types and access 
in terrela teo 

Private Volumes _ 

User Account C:=:> 
Public Volumes 11111111111 RW Acess 

Uncontrolled Volumes ~ RO Access ---if> 

Key 
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Setting Up the Network 

This section describes how to set up the hardware and configure your 
network. It includes instructions for the initial installation process and for 
making additions to the network later. 

Whether you're setting up an entirely new network system or just adding 
new hardware and Constellation III for the Macintosh to an existing 
network, you will need to follow the instructions in this section. 

If you are already running Constellation III for the Macintosh on an 
existing network and now ""'ish to upgrade your system for Release 2.0, 
please refer to Appendix A, Upgrading Your Constellation III for Macintosh 
Network. 

For a new network, you will need to work through the entire chapter. 

If you are adding Constellation III for the Macintosh to an existing 
Constellation for Apple or IBM network, then you should follow the 
instructions for Connecting A Macintosh to the Network, and for 
Initializing a Non-Macintosh Constellation Drive for Macintosh Use. 

If you are simply transferring an OmniDrive from another Constellation III 
for the Macintosh network to your network, then you need follow only the 
directions for Initializing An OmniDrive From A Different Constellation III 
For Macintosh Network. 

SETTING UP NEW EQUIPMENT 

The following hardware items are required to set up the OmniDrive: 

II OmniDrive 
II Power Cord 
.. Tap or Drop Cables 
• Transporter Network Interface Card 
• Trunk Cables 
11 Trunk Adapters 

Setting Up the Network 3-3 



-Corvus Systems, Inc. 

If you are not familiar with how to set up cabling for 
an Omninet network, please refer to Corvus's Omninet 
Cabling System II Installation Guide for further 
inf orma tion. 

SETTING UP THE OMNIDRIVE 

Handle the OmniDrive with care. Place it on its base on a flat surface 
where the air vent on the back panel is not blocked. 

To set up the OmniDrive and connect it to the Macintosh, 

1. Set the OmniDrive switches. 

3-4 

Find the switches marked ADDRESS on the back of your OmniDrive. 
Choose an address between 0 and 63. If this is the first OmniDrive on 
your network, the address should be set to O. Setting it to 0 will make 
certain network functions easier. If you are adding the OmniDrive to 
an existing network, the address must be unique. Set the drive by 
pushing the switches toward or away from the numbers, using the table 
on the following page for reference. 

';~~~~~~;I ~ 
II~OOOOQII ~o 
Illiilll 0 
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Switches 7 and 8 are not used for setting the device address. Switch 7 
should be pushed toward the numbers for ALL OmniDrives. Switch 8 is 
the bias switch. Only one OmniDrive on a network should have the 
bias switch pushed toward the numbers. 

SWitch Setting SWitch Setting 
Address 1 234 5 6 Address 1 234 5 6 

0 • • • • • • 32 · .. II • 
• C 1 C • II II • • 33 C • 

• II 
II C 

2 II C " . • II 
34 

• C • II • C 3 C C 
• II 

II • 35 CC 
• II 

II C 
4 

• II 
C II II II 36 II • C • II C 

5 C • C III II • 37 C • C • II C 
6 

• C 
C II II II 38 

• C 
C • • C 

7 C C C • II .. 39 C C C II II C 
8 II III 

• C 
... 40 ••• .. C II C 

9 C • II C II • 41 C II II C II C 
10 • C 

• C • • 42 .. C II C 
• C 11 C C .. C II II 43 C C fJ C .. C 

12 .. . C C 
• II 

44 II II C C II C 
13 C II C C II .. 45 C II CC III C 
14 II C CC II • 46 .. C C C • C 
15 C C CC II II 47 C C C C .. C 
16 51 II 

• II 
C II 48 II II II II C C 

17 C II ... C II 49 C II II II C C 
18 II C II II C II 50 .. C II .. C C 
19 C C II II C .. 51 C C .. II C C 
20 .. II C .. C .. 52 .. .. C III C C 
21 C III C .. C .. 53 C II C .. C C 
22 II C C II C II 54 .. C C .. C C 
23 C C C II C II 55 CC C II C C 
24 II II II C C II 56 iii EI II C C C 
25 C II 

• C 
ell 57 C II .. C C C 

26 
• C 

II C C II 58 .. C II C C C 
27 C C II C C EI 59 CC II C C C 
28 .. II CC C II 60 .. . C C C C 
29 C • C C C II 61 C II C C C C 
30 II C CC C II 62 

• C 
Cc C C 

31 C C Cc C .. 63 C C C C C C 
Address 1 234 5 6 Address 1 234 5 6 

Switch Setting Switch Setting 

II swHch towards nurrber 

C sw~ch <IN<rf from nurrber 

Network Device Addresses 
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2. Attach the tap or drop cable to theOmnidrive. 

Plug the three-slot connector at the end of the drop cable into the three
pronged connector marked TAP, next to the switches, on the back of the 
OmniDrive. 

3. Connect the tap or drop cable to the tap box or trunk adapter on the 
network. 

4. Plug the power cord into the OmniDrive and into a power outlet. 

5. Turn on the OmniDrive. 

The OmniDrive power switch is on the back panel above the power cord 
connector. 

Once the drive is turned on, the three lights on the front panel will 
come on. After about twenty seconds, only the READY light should 
remain on, indic·ating that the drive is ready for use. 

If the READY light is not the only light on after one minute, reset the 
OmniDrive by turning it off, waiting 20 seconds, then turning it back 
on. If the READY light still does not come on correctly, recheck all 
connections. If the drive still does not respond correctly, call Corvus 
Customer Service. 

SETTING THE DEVICE ADDRESS FOR THE WORKSTATION 

You must set the device address for your workstation on the Transporter 
before you connect it to your workstation. Allowable addresses are 0 
through 63, and the device address of your workstation must be different 
from the address of any other device on your network. Your network 
manager should be able to give you an address for your workstation. 
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1. Locate the switch box on the end of the card. 

Transporter Network Interface 
Card, showing location of switch 
unit. 

2. Set the switches to the device address assigned to your workstation 
according to the table of Network Device Addresses on page 3-5. Make 
a note of your device address. Switches 7 and 8 are not used. Set them 
to the ON position, i.e., toward the numbers. 
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CONNECTING THE TAP OR DROP CABLE TO THE TRANSPORTER 

Attach the three-slot socket at one end of your tap or drop cable to the 
three-pronged plug next to the switch box. 

Connecting the hip or drop cable 
to the Transporter. 

Turn off your Macintosh before proceeding with Transporter installation. 
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CONNECTING A MACINTOSH TO THE NETWORK 

Macintosh 512K 

1. Plug the nine-pin connector (at the end of the ribbon cable that extends 
from the Transporter) into a serial port at the back of the Macintosh. 
The nine-pin connector can be attached to either the printer port or the 
modem port. 

7~:f70Ta- Transporter 

Transporter connects 
o modem port 

or printer port 

Mac 512K Transporter installation. 
Connect to either modem or 
prin ter port; configure your 
Startup diskette accordingly. 

Your Transporter Network Interface Card is now installed. Connect the 
other end of the drop cable to a trunk adapter and your Macintosh is 
connected to the network. 
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Macintosh Plus 

If you have a Macintosh Plus, follow these instructions: 

You need the special Corvus adapter cable (Corvus Product Code MCBL) for 
the Macintosh Plus in order to connect your Transporter. 

Transporter attaches 
to single 9-pin 
D-connector 

Male end of double
ended D-connector 
on adapter cable plugs 
into mouse port 

Mouse plugs into 
female end of double
ended D-connector on 
adapter cable 

Mac Plus Transporter installation. 
Note mouse connector plugged 
into adapter cable. 

Transporter 

8-p;n m;n;-c;rcular 
----"rnnnPrtor plugs ;nto 

modem port or pr;nter port 

1. Plug the male end of the double-ended 9-pin D-connector on the adapter 
cable into the mouse port on the back of your Mac. Tighten the screws. 

2. Plug the mouse into the female end of the double-ended 9-pin D
connector. (This connector has two cables coming out of it). Tighten 
the screws. 

3. Attach the flat ribbon cable from the Transporter to the matching 
single D-connector on the adapter cable. Tighten the screws. 
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4. Plug the 8-pin, mini-circular connector on the adapter cable into either 
the modem or printer port, depending on which one you are using for 
your configuration. 

Your Transporter Network Interface Card is now installed. Connect the 
other end of the drop cable to a trunk adapter on your network. Your 
Macintosh is now connected to the network. 

Macintosh SE or Macintosh II 

If you have a Mac SE or Mac II, follow these instructions: 

You need the special Corvus adapter cable (Corvus Product Code M2CBL) 
for the Macintosh SE or II in order to connect your Transporter. 

T ransporter-~---';;"i:·\: 

G!~;;;I B-pin mini-circular 4-pin mini-circular 
connector plugs i 
Apple Desktop Bus port 

connector plugs into 
modem port or printer port 

Mac SE and Mac II Transporter 
installation. SE shown; port 
connection is the same for Mac II 
configura tion. 

1. Plug the connector at the end of the ribbon cable extending from the 
Transporter into the matching connector on the adapter cable. Tighten 
the screws. 
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2. Plug the 8-pin, mini-circular connector into either the modem or printer 
serial port, depending on which one you are using for your 
configura tion. 

3. Plug the four-pin, mini-circular connector into the Apple Desktop Bus ™ 
port on your Macintosh SE. 

Your Transporter Network Interface Card is now installed. Connect the 
other end of the drop cable to a trunk adapter. Your Macintosh is now 
connected to the network. 

Initializing an Omnidrive 

There are three separate procedures for initializing OmniDrives. They vary 
slightly, depending upon the circumstances under which you are initializing 
the drive. 

• If you are initializing a new drive on a new network, you will need 
to update the firmware and then use the Setup drive function in 
the Installer menu. 

• If you are adding Constellation III for Macintosh to an existing 
dri ve that has been in use with Cons tell a tion III for Apple or IBM, 
you will need to use the Corvus volume update in the Installer 
menu. 

• If you are adding an Omnidrive to your network that has been in 
use on another Constellation III for Macintosh network, you will 
need to Merge network user tables from the Installer menu. 

Complete directions for initializing a drive in each situation follow. 
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INITIALIZING A NEW OMNIDRIVE ON A NEW NETWORK 

Before a new OmniDrive can be used with a Macintosh, the firmware must 
be updated and the drive must be set up, or initialized. When a drive is 
initialized, a volume called CORVUS is created. The CORVUS volume 
contains tables that are used to manage the storage area on the drive. 

Updating the Firmware 

Before any computer can communicate with an OmniDrive, a firmware file 
must be copied onto the drive. This step uses the Corvus Diagnostic 
program. After you have made copies of the original Corvus diskettes, 
follow the steps below, using your copies of the orginals. 

1. Insert the Corvus Diagnostic diskette. 

Click twice on the Diagnostic diskette icon, and again on the Diagnostic 
program icon to open the application. . 

2. Select the server and drive. 

The server name displayed is SERVERnn, where "nn" is the network 
address of your OmniDrive. If you only have one drive on the network, 
it will be selected automatically. If you have more than one drive, type. 
in the name of the drive you want. Click the Select button. 

3. Pull down the Diagnostic menu and select Update FW. 

You will be asked if you want to update the firmware on the server 
you have selected. If the server and drive displayed are correct, 

4. Click OK. 

A message is displayed indicating that the firmware is being updated, 
then you are asked to reset the drive. 

5. Reset the drive. 

Reset the drive by turning it OFF and then ON again. Once the drive's 
ready light is lit, 

6. Click OK. 
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The Corvus Firmware is now added to your drive. 

7. Pull down the File menu and select Quit. 

You will be returned to the desktop. You should now initialize the 
drive. 

8. Eject the Diagnostic diskette, then initialize the drive. 

Initializing a new OmniDrive: 

1. Insert the Mgr diskette and double-click the Corvus Installer program 
icon. 

The screen displays three options: Setup drive, Merge network user 
tables, and Corvus volume update. 

2. Select the Setup drive button. 

Click the button labeled Setup Drive. The OK button darkens. 

o COrL/US Instnller 

@ Setup driue Cnncel 

o Merge network user tobles Ok 
o COrL/US uolume updnte 

3. Click OK. 
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The Setup Drive screen will appear. 

o Setup Driue 

Select driue 

Seruer 
Nome 

Driue 
Nome 

I :ueruernOlij·;: I 
I Hdriuenome 

4. Select an OmniDrive. 

seruedr I ~seruerposs I 
Posswor . . 

poss~~r~ I Hdriueposs I 

Concel 

The screen should show only one OmniDrive icon with the drive's 
network address. Select this drive by clicking on the drive icon. A box 
is drawn around the drive, the Setup button darkens, and default server 
and drive names appear. 

5. Check the server and drive. 

The OmniDrive has a built-in disk server that should be assigned a 
name and a password. The drive also should be assigned a name and a 
password. Defaults for the server and drive name will appear at the 
bottom of the screen. Accept or change these default values. Assign 
passwords for the server and drive by clicking the pointer in the boxes 
labeled Password and typing one in. Before continuing with Step 6, 
write the server and drive names and passwords below. 

Server Name ---------------------------------------------------
Server Password -----------------------------------------------
Drive Name -----------------------------------------------------
Drive Password ---------------------------------------------------
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6. Click Setup. 

You will be warned that the initialization procedure will destroy any 
existing data on the drive. . 

7. Click OK. 

A message appears on the screen indicating that the drive is being set 
up. Once the process is complete, the screen displays a message 
indicating that the drive is set up, and asking you to turn the drive off 
and then on. 

8. Reset the drive. 

Turn the drive OFF and then back ON. Once the drive's Ready light is 
lit, 

9. Click OK. 

The screen displays the main menu of the Installer program. 

10. Click Cancel to exit the Installer program. 

INITIALIZING AN OMNIDRIVE ON A NON-MACINTOSH 
CONSTELLA TION NETWORK FOR MACINTOSH USE 

If you are adding Constellation III for Macintosh to a drive on a network 
that has been used with Constellation III for Apple or IBM, you will need to 
to do the following: . 

1. Insert the Mgr diskette and double-click the Mgr diskette icon to open 
it. 

2. Double-click the Installer program icon. 
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The screen displays three options: Set up drive, Merge network user 
tables, and Corvus volume update. 
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3. Select the Corvus volume update button. 

Click the button labeled Corvus volume update. The OK button 
darkens. r----------------------------------------, 

_D Coruus Instllller 

o Setup driue (. Cllncel 

o Merge network user tllbles ( Ok 

@ Coruus uolume updllte ~ 

4. Click OK. 

A message will appear telling you that the Corvus volume is being 
updated. 

5. Reinsert your Startup diskette. 

The screen will now confirm that the update process has been 
completed. 

6. Click OK, then click Cancel to exit the Installer program. 

Your OmniDrive is now ready for use. 
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INITIALIZING AN OMNIDRIVE FROM A DIFFERENT CONSTELLATION 
III FOR MACINTOSH NETWORK 

If you are adding an OmniDrive that has previously been in use on another 
network running Constellation III for Macintosh, do the following: 

1. First, boot up using the Diagnostic diskette, then eject it, insert the Mgr 
diskette, and double-click the Mgr diskette icon to open it. 

2. Double-click the Installer program icon. 

The screen displays three options: Set up drive, Merge network user 
tables, and Corvus volume update. 

3. Select the Merge ~etwork user tables button. 

Click the button labeled Merge network user tables. The OK button 
darkens. 

_D Coruus Installer 

o Setup driue Cancel 

@ Merge network user tables 

o Coruus uolume update 

Ok 

4. Click OK 

The screen displays a drive icon for each OmniDrive on the network. 

5. Select an OmniDrive. 

Below each drive icon is the drive's Omninet address. 
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6. Click the drive you wish to add. 

A box is drawn around the drive, and the Merge button darkens. 

7. Select the Merge button. 

A message appears indicating that the current server's users will be 
added to the network. 

8. Click OK. 

A message is displayed saying that the user tables are being merged. 
Once the ·process is complete, another message appears indicating that 
the network user tables were successfully merged. 

\ 9. Click OK. 

The screen displays the Main Menu of the Installer program. 

10. Click Cancel to exit the Installer program. 

Your Omnidrive is now ready for use. 
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The Network Manager 

The Network Manager is the individual assigned to install and maintain the 
network. Initially, the Network Manager coordinates the installation 
process, makes sure hardware and software are in place, and sets up the 
first users and volumes. Once the network is installed, the Network 
Manager's responsibilities are to maintain the network: create new users, 
update old volumes, add new devices, etc. 

NETWORK MANAGER'S NOTEBOOK 

Keeping a notebook with relevant information about the network simplifies 
the Network Manager's responsibilities. 

The notebook should include the following: 

• Diagram of trunk line and tap box or trunk adapter locations 
a List of volumes and their attributes 
.. List of network users 
• List of server and drive names and passwords 
II List of spare tracks 
• Record of any diagnostic operations performed on an OmniDrive 
II List of network device addresses 

A quick and efficient way to create the volume, user, and drive lists is to 
use the Print option in the Network Manager program. This option is 
discussed in the section on Printing Lists in Chapter 5. 

Creating the First User 

The Network Manager should be the first user created for the system. This 
user will have several special capabilities that no other user on the network 
should have. 
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To create a Network Manager user: 

1. Insert the Corvus Mgr diskette. 

2. Double-click first on the Network Mgr diskette icon, and then on the 
Network Mgr icon to open the Network Manager program. 

The network drives will be listed on the screen. 

C File Uiew Options Mise Pipes 

NetuJork Manager 

DriIJes SerIJer Host # 

DRIVEl SERVERO 0 111111 

Uelele 

Sel(!( t 

[ [hIIlHJI' 1 

Sewer: Driue: 

3. Click anywhere on the row to select the correct drive. Click the Select 
button. 

The server and drive names will darken, and a box asking for the 
Server password will be superimposed on the screen. This will be 
followed by a box asking for the Drive password. 

4. Enter the Server and Drive passwords. 

Refer to Chapter 3 for the passwords you assigned. Enter both 
passwords, pressing return after each one. 

5. Pull down the View menu and select Users. 
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The User table displays a list of each user's name, password, and boot 
operating system. Since this is the first Macintosh user you are adding, 
the table will be empty. 
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6. Click the Add button. 

A screen asking for user inf orma tion appears. 

" File Uiew Options Misc Pipes 

Networic Manager 

Users On C, 

User name: ~~ I lDI 
User password: I I ~ 
Home seruer: I S£llUERO I 

~ o OS type: MAC 

~ 

o Deuice booting ~ 
Seruer: OD [ [onrel ) 

.-

7. Enter a name and password. 

The User Name can have up to 10 characters (letters, numbers, and 
periods). You can enter a password, if you like. 

To enter a password, move the cursor to the password box, click, and 
type the password. The password can have up to eight characters 
(letters, numbers, and periods). 

The user's operating system type should be set to Mac, and the home 
server should be the drive you selected earlier. The Device booting 
square should not be marked. 

8. Click OK. 

The new User Name for the Network Manager will appear in the user 
display table. 
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Making The First Three Macintosh Volumes 

The next step for a Network Manager is to create three specific volumes on 
the network. 

The first volume should be a private System volume for the Network 
Manager containing the network management software and the System 
folder. 

The second volume should be a public volume that contains the network 
utilities for users. 

The third volume you need to create is the Pipes volume, which is a sepcial 
volume used for print spooling and transferring files. 

THE MANAGER'S PRIVATE SYSTEM VOLUME 

To create a private volume for the Network Manager, from the Network 
Manager program, 

1. Pull down the View menu and select Volumes. 

4-6 

If you are upgrading an existing system, you will see a list of volumes 
and the segments of unused space available on the drive. Each unused 
row on the display represents a segment of available space at a certain 
address on a drive. It is with these segments of unused space that you 
create new volumes. If you are setting up a new network, and there are 
no previous volumes existing, you will see only the unused space on the 
dri ve you selected. 
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It File Uiew Options Misc Pipes 

Netiliolic Manager , 

Uolumes Location Size Type 

[unused! 13525 29619 111111 

~ 
Uelete 

CI(!dr 

( I: hllll,!P I 
Seruer: SERVERO Driue: DRIVE 1 

2. Click on an unused row. 

The Add button will darken. 

3. Click the Add button. 

A list of operating systems will appear. 

4. Select the button labeled Macintosh and click OK. 

A menu showing attributes to assign to your new volume will appear. 

It File Uiew Options Misc Pipes 

Network Manager 

Uolu 
.-------- Uolume name: c=~~ .. r. Uolume password: I I 

Uolume owner: IJRNEL I ~ 
Rccess type: 

~ o Uncontrolled o Public 

o Controlled @ Priuote EJ 
'--- Uolume size: 
SerUE o Small @ Large 

'---- i--------
OMedium o H-Lorge 

o Custom .. o Recouer .. 

~ ( Cancel I 
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5. Enter a name for your volume. 

Up to ten characters (letters, numbers, or periods) are permitted. 

6. Enter a password up to eight characters long. 

If you want a password, click anywhere in the box for volume 
password, and type in the password. 

7. Choose the access type. 

Private is already selected. This is correct for the private N.etwork 
Manager's System volume that you are making. 

8. Choose the volume size and click the appropriate button. 

Blocks 

kb/MB 

Small 

804 
400kb 

Medium 

1604 
800kb 

Large Extra-Large 

3204 6404 
1.6MB 3.2MB 

The above table shows size equivalents for standard volumes. You 
should choose lar'ge or extra-large for the Network Manager's private 
System volume. The buttons are dim for any volume size requiring 
more unused space than there is in the segment you've selected. 

9. Click OK. 
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Clicking OK returns you to the Volume display. It also adds the 
volume you've just created to the list of volumes in the display. 
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THE FIRST PUBLIC VOLUME 

To make a public volume, you follow the same procedure as above, except 
tha t you click on the public button in the menu tha t lists volume a ttri bu tes 
instead of accepting the default (private). 

THE PIPES VOLUME 

The third volume that a Network Manager must create is the Pipes volume. 
The Pipes program makes both printing and file transfer between users 
possible. 

To create the Pipes volume, from the Network Manager program, 

1. Pull down the View menu and select Drives. 

A list of your drives will appear. 

2. Select the drive having network address zero. Click the Select button. 

3. Pull down the View menu and select Volumes. 

A list of your volumes will be displayed. 

4. Select the unused space. 

In the volume ta ble, click on an area of un used space. The row of the 
selected area will darken. Do not click Add. 

5. Pull down the Pipes Menu and select the Create option. 

The screen prompts for the size of the pipes volume. 

6. Determine the size of the Pipes volume. 
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Move the pointer to volume size box and click. Type the size of the 
Pipes volume. The recommended size for the pipes volume is 1000 
blocks. 

7. Click OK. 

a File Uiew Options Misc • I' 

Uolumes 

MGR 
PUBLIC 

Network Manager 

Location Size Type 

509 6404 Public 
6913 3204 Public 

Rdd 

Chwr 

[ 1: hllll 11 I' I 

Seru Enter size of PIPES volume: 1,-1_00_0_-, 

QD [ancel 

~ 

The Pipes volume is now created and will appear in the volume table. 
In the future, however, you will not see it listed in the Volumes table 
unless you turn off the Mac volumes option in the Option menu. 

At this point you can continue to create volumes or you can go on to 
make your Startup diskette. When you are finished creating volumes, 

8. Pull down the File menu and select Quit to return to the Macintosh 
desktop. 
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Making the Network Manager Startup Diskette 

To create the Network Manager Startup diskette: 

1. Initialize a new diskette and label it "NetMgr Startup". 

2. Create a new folder on the diskette and label it "System Folder". 

3. Add files to the System folder. 

The System folder should contain the following files: 

• System (version 3.2 or later) 
• Finder (version 5.3 or later) 

Also, if you have a 512K, one that is neither enhanced nor a Macintosh 
Plus, copy: 

• Hard Disk 20 

These files are all available from your Apple dealer, and are also on the 
Corvus Diagnostic diskette. You must use the latest versions of these files. 

It is essential that the System file and the Finder on the 
Startup diskette be exactly the same version as those in 
the System volume. Your new private System volume 
should have no files in it at this point. When you add 
these System and Finder files to your System volume, 
you will insure that they are they same by copying them 
from the Startup diskette that you are creating now. 

You must also add one of the following two files from the Corvus User 
Diskette to the System folder: 

II Corvus Modem Port 2.0 
• Corvus Printer Port 2.0 

Which file you add depends on which port you will use to connect your 
Transporter. If you will be using the modem port, for example, copy the 
Modem file. 
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From the Corvus User diskette, copy the files 

• Logon 
• Mount Manager 

to the Startup diskette, but not to the System folder. 

When you have finished copying the files onto your new Startup diskette, 

4. Select (but do not open) the Logon icon. 

5. Pull down the Special menu on the desktop and select "Set Startup". 

You have now created the first Startup diskette. The same procedure is 
used to create Startup diskettes for other users. 

You can modify your Startup diskette to mount your volumes automatically, 
by following the steps in the next section, but first you should test your 
new diskette. To do that, simply shut down your Macintosh and then use 
your new Startup diskette to log on. 

AUTOMOUNTING VOLUMES WITH SNAPSHOTS 

Snapshots provide a method of mounting volumes automatically at the time 
you log on. The Mount Manager program allows you to select up to six 
volumes to be be mounted each time you run the Logon program. Taking a 
snapshot creates a special automount file that does the mounting for you. 

To take a snapshot, 

1. Log on using your Startup diskette, then open the Mount Manager 
program by double-clicking the Mount Manager icon. 
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The Mount Manager menu will appear, listing the volumes you have 
available for mounting. 

" File Snopshot Info Show 

" " • ,'Mount Manager: U$er JANEL', .' ,'" {' 

Uolumes 
MGR 
PUBLIC 

Driue 

... DRIVE 1 
'\: DRIVE 1 

Access 
Priv 
Pub! 

[Mllllnt 1l.;O] 

[ IJnMllllnt ] 

2. Click on the name of any volume that you would like to have mounted 
automatically each time you log on, then click Mount R/W or Mount 
RIO. Repeat this step for each volume you would like to add to your 
automount snapshot. 

The names of the volumes you have chosen will be shown in boldface, 
which indicates that they have been mounted and are now ready for 
use. You may select whichever volumes you like, but you must include 
your System volume. Mount the System volume with the button marked 
R/W. Mount other volumes with either R/W or RIO, depending on the 
volume type. 

3. Pull down the Snapshot menu and select Take. 

A screen showing the volumes you have chosen and asking you to select 
your System volume will appear. 

4. Select your System volume by clicking on its name and then clicking the 
Select volume button. 

A box showing available locations for saving your snapshot and listing 
your User name as the default name for the snapshot will appear 
superimposed on the screen. 
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5. Click the Drive button until your Startup diskette is displayed. 

Ii File " 
, Info Show 

Mount Manager: User JAN£L 

Uolumes Driue Access 
MGR DRIVE 1 Priv tQJ ['-1tt ltB:OJ 

I (g) NetMgr Startup I 
~ (ft 1.01100 Q (g) NetMgr st .. , 

(ft1'1ollnf '1!JI· 
D ~I: .. (!(!n 0 [ Eject 1 
L) ~I:n~(!n I 

CDriue IJ ~ L) ~I: .. (!(!n J. 
Cl System Folder 0-
Name of snapshot? [ Saue 1 

1~1'1~li I ( Cancel ) 

You must save the snapshot on your Startup diskette. Do not save it on 
your System volume. The name of the snapshot is, by default, your 
User name. 

6. Click on the Save button. 

Your snapshot has now been saved on your Startup diskette, and the 
volumes you selected will be mounted automatically each time you log 
on. 

You may now either pull down the File menu and select Quit to exit the 
Mount Manager program or remain in the program to make your volumes 
HFS and add files to them. 
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Making Volumes HFS 

Wi th Constellation III you can make MFS volumes in to HFS volumes. 

This process completely erases any data on the volume, 
so you should convert your volumes be/ore you add files 
to them. If you want to convert a volume that already 
has data in it, you must back up any data you wish to 
keep be/ore you convert it. 

To convert volumes from MFS to HFS: 

1. Use the Mount Manager program from your Startup diskette to mount 
any volumes you want to convert which are not already on the desktop. 
Open the program and select any volumes that you wish to convert. Pull 
down the File menu and select Quit to return to the desktop. 

2. Select (but do not open) the volume to be modified. 

3. Pull down the Special menu. 

4. Select the Erase Disk option. 

A box naming the volume to be erased and asking you to cancel or 
initialize the operation will be superimposed on the screen. 

5. Click the Initialize bu tton. 

Your volume is now an HFS volume. 
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Adding Files 

You should now copy files to the first two volumes you created. The 
following should be added to your private System volume: 

• System Folder (from Startup diskette) 
• Network Manager program (from Mgr diskette) 
• DMM (from Mgr diskette) 
• Font Dj A Mover (from Apple System Tools diskette) 

Then, from the User diskette, copy: 

• Logoff 
• Logon 
• DjA 
• OmniWriter 
• OmniPrep 
• Modem Port or Printer Port (depending on which port you will 

use to connect to the network) 

You may add whatever applications programs you wish to the public 
volume, but you should also add the following files, all found on the User 
diskette: 

• Mount Manager 
• File Transfer 
• Pipes 
• Logoff 

If you converted your volumes to HFS, then they should already be mounted 
on the Macintosh desktop. If you decided not to convert them, then you 
must use Mount Manager, as in the above directions on Automounting 
volumes, to mount your volumes on the desktop before you can add files to 
them. When your volumes are mounted, you can copy files to them using 
standard Macintosh procedure. 
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Maintaining the Network 

In addition to setting up the Constellation III system initially, the Network 
Manager must also perform certain tasks periodically to update and 
maintain the system. These tasks include adding and deleting users and 
volumes, checking stats, changing passwords, and managing access. This 
section describes the routine tasks a Network Manager must perform to 
maintain the network. 

Adding Users 

Users may be added to the network at any time. Startup diskettes are 
usually made at the same time that users are added. 

To add a user, 

1. Open the Network Manager program and click the name of the Drive 
assigned to the new user then click on the Select button. Enter 
passwords, if required. 

2. Pull down the View menu and select Users. 

3. Click the Add button. 

A menu listing user attributes will appear. 

4. Enter the user's name (and optional password). 

The user's name can have up to 10 characters (letters, numbers, and 
periods). To enter a password, move the cursor to the password box, 
click, and type the password. The password can have up to eight 
characters (letters, numbers, and periods). 

5. Enter the name of the home disk server. 

Either accept the default home disk server name and continue, or move 
the pointer to the home disk server box, double-click, and enter a new 
disk server name. 
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6. Select the user's operating system. 

The default operating system type should be MAC. If it is not, click 
the as type button and select the Macintosh operating system by 
clicking the button labeled MAC. If you are creating a user for a 
computer other than the Macintosh, click on the desired operating 
system. 

7. Click the Device booting box, if you want the user's workstation or the 
device to log on automatically, then click OK. If you do not want the 
user's workstation to log on automatically, go directly to Step 8. 

5-4 

Another menu will be superimposed on the screen. The default device 
type should be set to Workstation. 

It File Uiew Options Mise Pipes 

Network Manager 

Users n, (" 

-
JANEL User nome: IBINKY I :tal 

User possword: 
I I S 

Home seruer: I SERUERO I 
~ o OS type: MAC 

r8I OelJiee booting ~ 
Sewer: o OelJiee type: WORKSTATION 

~ 
CJ Host number: 

~ ( Coneel 1 
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If it is not, click the Device type button and select Workstation from 
the menu that will then appear. 

" File Uiew Options Misc Pipes 

Network Monoger 

Users n~ (' 

JANEL User nome: IBINKY I -User possword: I I ~ 
Home seruer: I SERUERO 

.n~ 

I ~ 
OB,onk 

'---

o OmniDriue ~ 
Serue o Boot Deuice o Print Seruer 

'---- o Mirror Seruer @ WorkStotion 
f-----' 

~ 
OK:] ( (oncel 1 

Click OK to return to the previous menu, then type in the Omninet 
address of the Macintosh that will perform the device boot. If you do 
not know the address, compare the setting of the address switches on 
the Macintosh's Transporter box with the network address chart in 
Chapter 3 of this guide. When you have entered the information, click 
OK. 

8. Click OK to create the user. 

The user's name will appear in the list of users. 
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Adding a Standard Volume 

Adding a standard volume is the quickest and easiest way to create volumes. 
You need only the volume name and any password you want the volume to 
have. 

From the Network Manager program, 

1. Select the drive on which you want the new volume to be located and 
enter passwords, if required. 

2. Pull down the View menu and select Volumes. 

At the end of the list of volumes are the segments of unused space 
available on the drive and their sizes. 

3. Select a segment large enough for the volume you want to create by 
clicking first on an unused row, then on the Add button. 

The Operating System option screen will appear. 

Uolumes 

MGR 
PUBLIC 

~ 

Serul 
'---

Network Mllnllger 

Loclltion 

509 
6913 

@Mllcintosh 
~ o MSDOS 

OCP/M 

o ProDOS 

o Other: 

Size Type 

6404 Privl'lte ~ 
3204 Publ1C J I 

OUCSD 

o DOS 3.3 

OUOS 

o Reserued 

II 

00 [ Cllncel 1 

M;bO-

I 

4. Click the MAC button to select the Macintosh operating system if it is 
not already darkened. Click OK. 

A menu of other volume attributes will appear. 
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5. Enter a volume name. 

Up to ten characters (letters, numbers, or periods) are permitted. 

6. Enter the volume owner's name. 

7. Enter a password up to eight characters long. 

If you want a password, click in the box for volume password and type 
in the password. 

8. Choose the access type. 

Private is already selected. To change the selection and make a 
different type of volume, click on the appropriate button. 

9. Choose the volume size. 

Blocks 

kb/MB 

Small 

804 
400kb 

Medium 

1604 
800kb 

Large Extra-Large 

3204 6404 
1.6MB 3.2MB 

The table above will help you determine the volume size you need. The 
buttons are dim for any volume size requiring more unused space than 
is in the segment you've selected. 

10. Click the button for the size volume you want. 

11. Click OK. 

Clicking OK returns you to the Volume display. It also adds the 
volume you have just created to the list of volumes in the display. 

Pull down the File menu and select Quit to exit to the Macintosh desktop or 
use the Launch option to go directly to another application. 
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ADDING CUSTOM VOLUMES 

Custom volumes are created in generally the same way as standard volumes. 
The only difference is that after you name the volume and choose its 
password and type, you select the Custom button. Then when you click OK 
a new dialog box appears. 

Custom volumes can be any size from 400 blocks (200 kb) to 65,536 blocks 
(32 Mb). Recommended directory size is 12 blocks. 

To add a custom volume, follow steps 1 through 7 under Adding a Standard 
Vol ume t then: 

1. Click the Custom button. 

2. Click OK. 

5-8 

The dialog box for adding a custom volume appears. 

C File Uiew Options Misc Pipes 

Network Monoger 

Uolu 
~ Uolume nome: IBINKY I • MGR 

~iiijdM~ 
Uolume possword: I I 
Uolume owner: IJANEl I IE] 
Access type: 

~ o Uncontrolled o Public 

o Controlled @ Prillote EJ 

I Uolume size in blocks: \3200 
"- ---' 

Directory blocks: ITO tt 

( OK ) ( Concel ) 

The edit box for volume size is highlighted and displays the largest 
number of blocks your custom volume can occupy in the segment of 
un used space you have selected. 
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3. Choose a volume size. 

To accept the highlighted volume size, leave it unchanged and go on to 
the other box. If you want a smaller volume, click in the volume size 
box and type in the number of blocks you want. The volume size must 
be from 400 to 65,536 blocks. If you choose a number outside this 
range, it will not be accepted and nothing will happen. 

4. Choose the number of directory blocks. 

Dou ble-click the box for directory size. Type the size directory you 
want, from 8 to 32 blocks. If you choose a number outside this range, it 
will not be accepted and nothing will happen. 

s. Click OK. 

An entry for the volume you've created will appear now in the Volume 
display table. 

Making User System Volumes 

Each user needs his own private System volume. To make a User System 
volume, first create a standard private volume. For now, you should enter 
the Network Manager's name as the volume owner. This facilitates adding 
the necessary files to the volume. Later, you will change the volume 
owner's name to that of the actual user. When you have created the volume, 
pull down the File menu and Launch Mount Manager. Mount the volume on 
the desktop, then create a new folder on the volume labeled "System folder", 
and copy the files listed below into the System folder. 

• System (version 3.2 or later) 
• Finder (version 5.3 or later) 

Also, if you have a Macintosh 512K, one that is neither enhanced nor a 
Macintosh Plus, copy 

• Hard Disk 20 
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These files are all available from your Apple dealer, and are also on the 
Corvus Diagnostic diskette. It is essential that you use the latest versions of 
these files. 

When you have finished copying the files, the System volume will be 
functional. However, if you want the user to be able to spool files to the 
network printer, you will also want to add spooling capabilities to the 
volume. If so, continue with the following section. If you do not want to 
add spooling capabilities to the user's System volume, then skip ahead and 
make a Startup diskette for that user. 

SETTING UP PRINT SPOOLING CAP ABLITIES 

With the user's System volume mounted, 

1. Copy OmniWriter from the User diskette into the System folder on the 
the user's System volume. 

2. Next, double-click the D/ A icon in the User diskette window. 

This will activate Font D/ A Mover. The Font D/ A menu will appear on 
the screen. 

3. Click the Desk Accessories button to select it, if it is not already 
darkened. 

The Corvus Spooler and the Corvus Despooler will be listed in the box 
on the left of the menu. 

4. Click the Open button on the right side of the screen. 

A box displaying the User diskette and several buttons will be 
superimposed on the screen. 

~ 

5. Click the Drive button until the user's System volume is displayed. 

6. Be sure the System folder is selected and darkened, then click Open. 

7. With the System folder open, be sure the system file is highlighted, then 
click the Open bu tton. 
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8. Select the Corvus Spooler from the left hand side, then click the Copy 
button to copy it to the user's System volume. 

o Font 
Mouer @ Desk Accessory 

Comus Despooler IQ ( » Copy» ) Allum Clock ~ 
I III' ~ Colculotor 

[ Remove) Chooser 
Control Ponel 

5549 bytes 
Key Cops 
Scropbook 

K5. select ed 10 
D/A System 

on MGR ( Help ) on RICHARD 
2630K free 526K free 

( Close 1 ( Quit 1 [[lOse) 

9. Click the Quit button to leave Font Dj A Mover and return to the 
desktop. 

10. Open the Network Manager program and select the drive on which the 
user's volume will reside. Enter passwords, if necessary. 

11. Pull down the View menu and select Volumes. 

12. Select the user's volume, then click the Change button. 

13. Change the owner name to that of the actual user, then click OK. 

14. Pull down the File menu and select Quit to return to the desktop. 

15. Unmount the user's volume by dragging it to the Trash. 

The user now has a System volume with print spooling capabilities. 
You should now make a Startup diskette for the user. 
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Making Startup Diskettes for Users 

To make a Startup diskette for your new user, 

1. Initialize a new diskette and label it "Startup diskette". 

2. Copy the System folder from the user's System volume onto the new 
Startup diskette. 

3. Copy one of the following two files from the Network Manager's System 
volume to the user's System folder: 

• Corvus Modem Port 2.0 
• Corvus Printer Port 2.0. 

Which file you add depends on which port you will use to connect to 
the network. 

4. Copy the following files to the user's Startup diskette, but not to the 
-System folder: 

• Logon (from the Network Manager's System volume) 
• Mount Manager (from the Public volume) 

When you have finished copying the files onto the new Startup diskette, 

5. Select (but do not open) the Logon icon. 

6. Pull down the Special menu on the desktop and select "Set Startup". 

You have now created the user's Startup diskette. Each user can customize 
his diskette to mount his volumes automatically at the time of logging on by 
using the Snapshot option. Refer to the instructions in Chapter 7. 
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Deleting Users and Devices 

From the Network Manager program: 

1. Select Users from the View menu. 

2. Select the user (or device) to be deleted. 

3. Click the Delete button. 

The screen displays information about the user and asks if you want to 
continue. 

Ii File Uiew Options Misc Pipes 

Network Manager 

Users Password Op Sys 

BINKV MAC lQ [ 111111 I 
JANEL C3 MAC 
KEITH MAC M't@M MONTV MAC 
RICHARD MAC 
ROB *MAC I Select I 
rm User name: TRG ~ -
Seru 

OS type: MRC 

'--- Home seruer: SERUERO -----" 

Do you really want to delete this user? 

D:Q~ ~ 

4. Click OK. 

The user's display table will once again appear, showing that the user 
you have deleted is no longer listed on the Network. 
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Changing Password, Home Disk Server, or Operating 

System 

If you need to change a user or device password, home disk server or boot 
opera ting system, use the Change option. 

You cannot change a user's name directly. You have to 
~ delete the user and then add that user to the system 

. under a different name. 

In the Network Manager program, 

1. Pull down the View menu and select Users. 

The User table will appear. 

2. Select an entry. 

Choose the user or device whose attributes you want to change. 

3. Click the Change button. 

A menu will appear listing the attributes that you may change. Enter 
the desired changes. 

C File Uiew Options Mise Pipes 

Network Manager 

Users Password Op Sys 

jlW V ' IIAC 111111 
JANEL C3 MAC 
KEITH MAC 
MONTY MAC 
RICHAR 
ROB 
RON User name: 

User password: 

Seruer Home sewer: I HOMESERUER 

o OS type: MAC 

QQ [ Cancel 
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3. Click OK. 

The changes have been made. 

Deleting, Recovering, Clearing, 

or Changing a Volume 

You can clear a volume of its contents, change a volume's attributes, or 
delete a volume entirely. 

DELETING A VOLUME 

it Deleting removes a volume and all its files from the 
network. All the information in the volume is lost. 

• Before deleting, be sure to save any files you want. 

From the Network Manager program, 

1. Pull down the View menu and select Volumes. 

A listing of all the Macintosh volumes appears. Some volumes on your 
network, such as the Pipes volume, are not Macintosh volumes and will 
not appear unless you pull down the Options menu and unselect the Mac 
volumes option. 

2. Click on the name of the volume you want to delete. 

3. Click the Delete button. 
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A box listing information on the volume you selected and asking if you 
really want to delete that volume will be superimposed on the screen. 

a File View Options Misc Pipes 

Network: MOnflger 

Volumes Locotion Size Type 

MGR 509 6404 Privete ~ [ 111111 ) 
PUBLIC 6913 3204 Public 
BINKVS 11117 804 Uncantral -.QMra ADMIN 11921 1604 Cantralle 

06 13525 16('''' Private 
DATABASE 15129 6404 Privete I Cleor 
RIC 
[un Volume nome: ROB J 
'-- Volume type: Mocintosh 
Ser Number of files: 1 

'----- -------' 

Do you reolly wont to delete this uolume? 

~ ~ --

4. Click OK. 

RECOVERING A VOLUME 

You can recover a volume that you have accidentally deleted as long as you 
have not written over the disk space that the volume occupied. 

From the Network Manager program, 

1. Select the drive on which the volume was located and enter passwords if 
required. 

2. Pull down the Vie~ menu and select Volumes. 

3. Select an area of unused space, then click the Add button. 
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A menu asking for the operating system of the volume you want to add 
will be displayed. 
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4. Select the operating system of the volume that has been deleted and 
click OK. 

A menu of volume attributes will appear. 

5. Type in the name of the volume that was deleted and click the Recover 
button. Click OK. 

The Recover dialog box will appear . 

• File Uiew Options Misc Pipes 

Network Manager 

Uolu 
,.---

Uolume nome: IRICHRRD I • MGR 
PUBLI Uolume password: 

I I 
BINKY f.:--
," Uolume owner: IJRNEl I le 

Constellation uolume nome: RICHRRD 

Macintosh uolume nome: RICHRRD 

Uolume size: 1604 

Directory blocks: 0 

Number of files: 2 
'-- f-' 

Do you wont to recouer this uolume? 

c;J ( Cancel I 

6. Click OK. 

If you have not written over the volume, it will be recovered and will 
once again appear in the list of volumes. 

CLEARING A VOLUME 

Clearing makes a volume an empty MFS volume. To make it an HFS 
volume, use the Erase Disk function from the desktop. 

Clearing a volume destroys the volume's files. Be sure 
you copy any files you want to save before clearing a 
volume. 
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From the Network Manager program, 

1. Pull down the View menu and select Volumes. 

A listing of all the Macintosh volumes appears. Some of the volumes on 
your network, such as the Pipes volume, are not Macintosh and will not 
appear unless you pull down the Options menu and unselect the Mac 
vol umes option. 

2. Click the name of the volume you want to clear. 

3. Click the Clear button. 

A box listing information about the volume you have selected and 
asking you if you really want to clear it will be superimposed on the 
screen. 

Network Monoger 

Uolumes Locotion Size Type 

MGR 509 6404 Private IQ [ HIIII 1 
PUBLIC 6913 3204 Public 
BINKVS 11117 804 Uncontrol [ Delete 1 ADMIN 11921 1604 Controll e 
ROB 13525 1604 Private 
DATABASE 15129 6404 Private 

~ 
[un Uolume nome: RICHRRD tJ l...- Uolume type: Mocintosh 
Ser Number of files: 2 

'--- I--

Do you reolly wont to cleor this uolume? 

c;J ~ 

4. Click OK. 

The display will return to the volume display list. 
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CHANGING A VOLUME 

A Network Manager can use this option to change a volume's name, 
password, owner, and type. 

The volume's size cannot be changed. To change the 
size, you must add a new volume, move the old volume's 
files to the new volume, and then delete the old volume. 
You cannot change a volume that is locked. In addition, 
if you wish to change an uncontrolled volume, you 
should verify that no one else has tha t volume moun ted. 

From the Network Manager program, 

1. Pull down the View menu and select Volumes. 

2. Click the name of the volume you want to change. 

3. Click the Change button. 

A menu showing the volume attributeswill appear. 

4. Enter any new information. 

Double-click the Volume Name, Volume Password, or Volume Owner 
boxes to highlight them, then type in your changes. If you wish to 
change the access type, click the appropriate button. 

C File Uiew Options Mise Pipes 

Network Mllnllger 

Uolume nllme: IDATABASE 

Uolume type: Mlleintosh te 

Uolume pllssword: 

RICHA Uolume owner: IJANEl 
[unuse 

Access type: 

Serue o Uncontrolled o Public 

o Controlled @ Priullte 

~ [ Cllncel 1 
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5. Click OK to register the changes. 

When you use Change to give a volume a new name, you 
change the Constellation name of the volume, but not 
the Macintosh name. The name of the icon representing 
that volume on the Macintosh desktop will not change 
unless you rename it on the desktop. Anytime you 
change the Constellation name, you should make sure 
that -the user with desktop read-write access to that 
volume changes the Macintosh name, as well. 

Finding A Volume 

You can find a volume by searching lists of the entire contents of each 
drive on the network. A faster method, however, is to use Find Volume in 
the Misc menu. 

In the Network Manager program, select a drive to search, then 

1. Pull down the Mise menu and select Find Volume. 

5-20 

A box asking you to enter the name of the volume to be found, and 
asking you to specify whether that name is a Constellation or Macintosh 
name will appear at the bottom of the screen. Ordinarily, the two 
names will be the same; however, if you have used the Change function 
to change only the Constellation name of the volume and have left the 
Macintosh name unchanged, or if you have changed the Macintosh 
volume name on the desktop, you will have to indicate whether the 
name you have specified is the Constellation name or the Macintosh 
name. 
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" File Uiew Options Pipes 

Network Manager 

Oriues Seruer Host # 

DRIVE 1 SERVERO o 111111 

[ I hllllllP 1 

.' ...' Find Uolume' ~ .. ;,,' }, '. 

Uolume name: <-I D_AT_A_BA_SE __ --" 

@ Constellation name 0 Macintosh name 

2. Enter either the Constellation or the Macintosh name. 

Type the name of the volume you want to find. 

3. Click the Search button. 

The computer searches for your volume and, when it finds it, highlights 
the name of the drive on which the volume is located. While the 
computer is searching, the cursor will appear as a watch. When the 
cursor becomes an arrow again, the search is finished. 

If the computer completes its search without finding your volume, the 
watch will change back to an arrow and none of the drives displayed 
will be highlighted. If this happens, there are several possible 
explanations: the volume may have been deleted and no longer exists; its 
name may have been changed; or the volume may be listed on the 
Constellation drive by a name different from the one that appears on 
the volume's Macintosh icon. 

4. Click the Quit button to return to the desktop. 
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Removing the Pipes Area 

From the Network Manager program, 

1. Select the drive named ServerO, on which your Pipes volume resides, and 
enter passwords, if necessary. 

2. Pull down the Options menu. If there is a check mark next to the Mac 
Volumes choice, select it to remove the check mark and turn off the 
Mac Volumes option. 

This will allow you to see all the volumes on the drive. With the Mac 
Volumes option on, you will see only the Macintosh volumes. Because 
the Pipes volume is a UCSD volume, not a Macintosh volume, you must 
unselect the Mac Volumes option in order to view it. 

3. Pull down the View menu and select Volumes. 

A listing of all your volumes on the selected drive will appear. 

4. Select the Pipes volume by clicking its name. 

* File Uiew Options Misc Pipes 

Netl1lork Manager 

Uolumes Locetion Size Type 

BlKS.O 7 0 8 RESERVE L:i§io:J 
BlKS 8 8 RESERVE 
CORVUS 9 500 UCSD 

[ Dele~ MGR 509 6404 MAC 
PUBLIC 6913 3204 MAC 

( [leer 1 
BINKYS 11117 804 MAC 
ADMIN 11921 1604 MA[ 

( [henge 1 
ROB 13525 1604 MAC 

Seruer: SERVERO Driue: DRIVE I 

5. Click the Delete button. 
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A box listing information about the Pipes volume and asking you if you 
really want to delete it will appear. 

6. Click OK. 

The pipes area is deleted. Now you must uninitialize it. 

7. Pull down the File menu and select Launch. Insert the Diagnostic 
diskette and open the Diagnostic program. Pull down the Pipes menu 
and select U ninitialize. Click OK. 

The pipes volume is now deleted and un initialized. 

Checking Stats 

The Stats option in the View menu provides information on users, volumes, 
drives, and the network as a whole. With the Stats option you can view 
names, sizes, passwords, and space usage. 

DRIVE STATS 

The stats for a drive show the drive name, size, total number of Macintosh 
and other volumes, and percentage of space used. To check drive stats: 

From the Network Manager program, 

1. Open the Drive display. 

This display will come on when you enter the Network Manager 
program. If you have been performing other tasks in the program and· 
are not currently viewing the Drive display, pull down the View menu 
and select Drives. 
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2. Select a drive. 

Click the drive's name to highlight it, but do not click on the Select 
button. 

3. Pull down the View menu and select Stats. 

Stats for the drive you selected will appear. 

C File IlII1III Options Mise Pipes 

Network Monoger 

Driues Seruer Host # 

( nllll 1 
I I I 

Drive nome DRIVEl 
Server nome SERVERO 
Drive size 43344 blocks, 21 megobytes 
Totol volumes 11, 53% of the drive 
Mocintosh volumes 7, 49% of the drive 

4. Click anywhere in the box to remove the display. 

VOLUME STATS 

For Macintosh volumes, the Stats sJ:tow volume name, password, owner, file 
block size, directory and file blocks, volume size in kilobytes, whether the 
volume is HFS, and a graphic depiction of used file space. 

In the Network Manager program, 

1. Select the drive containing the volumes you want to view. Enter 
passwords, if necessary. 
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2. Pull down the View menu and select Volumes. 

A list of Macintosh volumes on the drive you selected will be displayed. 
If you are interested in viewing a non-Macintosh volume, you will need 
to pull down the Options menu and unselect (remove the check mark 
from) the Mac Volumes option. 

3. Select a volume by clicking on its name, but do not click the Select 
button. 

4. Pull down the View menu and select Stats. 

Information about the selected volume will appear. 

" File Options Misc Pipes 

Network MBnBger 

Uolumes LocBtion Size Type 

MGR 
PUBLIC 

509 6404 PrivBte 
6913 3204 Public 

IW"VS'··· .. '" ,: : 1'1117 ".,;' SO:i;.t ; Un"contr6 
ADMIN 11921 1604 Contro1le 
ROB 13525 1604 Privete 
DATABASE 15129 6404 Privete 
RICHARD 21533 1604 Privete 
[unused) 23137 20207 

Volume nome : BINKY 
Volume owner : JANEL 
Volume possword 
File block size : 1024 bytes 
Directory bloclcs : 12 

~J 

Delete 

CleBr 

( ChBnge ) 

o i rectory: 01 
Fi lespace:OI 

5. Click anywhere in the box to remove the display. 
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USER STATS 

The stats for a user show the user's name, home disk server, and number of 
volumes he owns. To check User stats: 

From the Network Manager program, 

1. Pull down the View menu and select Users. 

2. Select a user by clicking the user's name, but do not click the Select 
button. 

3. Pull down the View menu and click Stats. 

Information about the user you selected will appear . 

• f File Option\ Mise Pipes 

Users 

BINKY 
JANEL 
KEITH 

Network Manager 

Password Op Sys 

MAC 
C3 MAC 

MAC 
lot~T'I IIAC 

RICHARD 
ROB 
RON 

MAC 
MAC 
MAC 

Seruer: SERVERO [IrilJe: DR IVE 1 

User Name : MONTY 
: SERVERO 

Number of Volumes : 0 

111111 

Delete 

Select 

[ Change) 

4. Click anywhere in the box to remove the display. 
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NETWORK ST A TS 

Network stats shows a map of the network, with the network address and 
device type for every active piece of equipment operating on the network. 

1. Pull down the View menu and select Network. 

Information about your network will appear in graphic form. 

" File II!ID Options Mise Pipes 

Network Manager 

Driues Seruer Host # 

BNKRELEASE BNKRELEASE 0 tQ ( 111111 ) 
DRIVE I SERVER48 48 

( [lelel(! ) 

[ s(!)(!( t 1 
0 1 2 3 4 5 6 7 B 9 

00 0 D = Disk server D - 10 " 
o = Omnidrive 

Sen B = Bank 
20 P = Print.r Sfrv.r 

'-- 30 " 
S = SNA 9at.way :---------
W = Workstation 

40 .; 0 i = tr ansportfr 

50 .; = you are her. 

60 " 

2. Click anywhere in the box to remove display. 
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Printing Lists 

The Print Option prints a complete list of whichever mode is currently 
displayed. Use this option to obtain a drive, user, and volume list for your 
Network Manager's Notebook. Use Page Setup to specify the size paper and 
format you want. To print a particular list: 

In the Network Manager program, 

1. Select a drive and enter passwords, if necessary. 

2. Pull down the View menu and select Users, Volumes, or Drives. 

3. Pull down the File menu. Select Page Setup to organize the output, 
then select Print. 

Changing The Drive Password 

To protect the contents of your drive, you should change drive passwords 
periodically. To change drive passwords: 

In the Network Manager program, from the Drive display, 

1. Select the drive with the password to be changed. 

2. Select Change. 

5-28 Chapter 5 



Constellation III for the Macintosh 

A screen for new password entry will appear. 

" File Uiew Options Misc Pipes 

Network Monoger 

Driues Seruer Host # 

( 111111 1 

( [i(!1<!1(! 1 

( Select 1 

K> 14'EI.I.[ji 

Driue Nome: DRIUEI 

Driue Possword: I I 

( OK ) ( [oncel ) 

3. Enter the new drive password 

Up to 8 letters, numbers, or periods may be used. 

4. Click OK. 

Managing Access For Other Computer Types 

If you have several different computer types on your network, each running 
the appropriate Constellation software, then occasionally you might find it 
necessary to manage volume access for non-Macintosh users and non
Macintosh volumes. Ordinarily you should manage other computer types 
using the software for that type of computer; however, you can use the 
Constellation III for Macintosh Access option to grant, remove, or change 
access to a volume for a selected user. The selected user"s operating system 
must be compatible with the volume's operating system. 
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Constellation III for Macintosh can be used with 
Constellation II for Apple and with Constellation 
software for the IBM. However, the current release is 
not fully compatible with the new Access function in 
Constellation· III for the Apple II. If you have Apple 
computers running Constellation IlIon your network, 
use the Apple Network Manager to manage them. 

In the Network Manager program, 

1. Pull down the Options menu and unselect the Mac Users option, then 
unselect the Mac Volumes option. 

This will remove the check mark from those options. 

2. Pull down the View menu and select Users. 

3. Click. on the desired user name, then click. the Select button. 

The user name that you have just selected will be listed on the menu 
title bar. 

4. Pull down the View menu and select Volumes. 

5. Position the cursor on the volume to which you want to grant, remove, 
or change access for the selected user. 

5-30 

Make sure the selected volume and user have the compatible operating 
systems. Compatible operating systems are shown below. 

User Volume 

MSDOS MSDOS 

IBM C2IV.O UCSD 

A2PASCAL UCSD 

DOS3.3 

A2DOS3.3 UCSD boot volume 

Apple PRODOS 

PRODOS UCSD boot volume 
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6. Pull down the the Misc menu then select the Access option. 

The screen displays the selected user's access to the selected volume. 

G File Uiew Options Pipes 

Network Monoger: User A2PRODOS 

Locotion Size Type 

1 1300 3000 eeos Hll11 

User nome: A2PRODOS te 

Uolume nome: PROUOL 

Uolume occess: 
II' 

o Reod only @ Reod/Write ge 

Unit: c=J o Boot uolume 

( HIIII HI:( ps~ ) ( Delete Access) 

( Chonge Access) Con eel 

7. Set the new Access attributes. 

Information on mount units and read-write and read-only access for 
non-Macintosh computers can be found in the Constellation Network 
Manager's Guide for the Apple II or the Constellation Network Manager's 
Guid e for the IBM PC. 
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Setting Up Printing 

There are two types of printers on a network: local and network. 

A local printer can be used only by the operator of the computer to which it 
is connected. Follow the printer manufacturer's instructions when you set 
up your printer as a local unit. 

A network printer can be shared by everyone on the network. 

Constellation III, unlike many other networks, offers true spooling 
capabilities for network printers. When you spool a file it is sent to a 
transfer area, called Pipes, where it awaits des pooling. Printing a file in 
this way has several advantages: 

• It frees your Mac for other tasks. 
II You can spool even if the printer is down . 
• The spooling functions operate transparently. 

The first step in setting up network printing capabilities is to select a 
printer and computer that will act as the Network Printer and Despooling 
Station. The printer must be connected to the selected Macintosh. The 
Despooling Station will serve to direct traffic coming to the printer; 
however, it does not have to be dedicated to that one task. A user can 
perform other tasks on the Macintosh that is designated as the Despooling 
Station even though other users may be spooling files. Despooling is a 
background task that doesn't interfere with the user. 

SETTING UP THE HARDWARE FOR A NETWORK PRINTER 

You can use a LaserWriter or an ImageWriter printer for your network 
printer. 

Cables are available that allow you to connect your Mac to a variety of 
printers. You can connect to either port on the Laserwriter. Set the config 
switch on the side of the LaserWriter to the 9600 position. Use standard 
serial cables to connect the LaserWriter. For Macintosh 512K, use the 
ImageWriter I cable to connect to the LaserWriter. For Macintosh Plus or 
Macintosh SE, use the Mac 512K to ImageWriter II cable. 

Setting Up Printing 6-3 



Corvus Systems, Inc. 

To connect an ImageWriter, simply follow the manufacturer's directions, 
using the standard ImageWriter serial cable that comes with your 
ImageWriter. 

SETTING UP THE DESPOOLING STATION 

Your despooling station can be a Macintosh that a user employs for other 
tasks, or it can be a dedicated, non-user Macintosh. Despooling is a 
transparent background function that does not interfere with the normal 
opera tion of the Macintosh. 

Setting Up a User Despooling Station 

To make a user's workstation function as a despooling station: 

1. Create a Startup diskette and a System volume for the workstation that 
will be the despooler. 

Create a Startup diskette and System volume for the despooler's user, 
remembering not to give ownership of the volume to the actual user just 
yet. Use the Mount Manager program on your Public volume to mount 
the user System volume that you have just created. Convert it to HFS, 
if you wish, then add the System folder from the user's Startup diskette 
to the volume. Remove the Corvus Modem Port from the System folder 
on the new System volume. 

2. Copy the OmniPrep program from the Network Manager's System 
volume to the new System volume. 
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Copy it to the root window of the System volume, but not into the 
System folder. You may also wish to copy the Pipes program from the 
Public volume to the System volume. If you do have Pipes on the 
des pooler System volume, you will be able to watch the progress of files 
as they pass through the transfer area; however, it will also be possible 
for the user to purge files in the Pipes volume that are waiting to be 
despooled. 
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3. Next, double-click the Corvus Dj A icon in the Network Manager's 
System volume. 

This will activate Font OJ A Mover. The Font OJ A menu will appear on 
the screen. 

4. Click the Desk Accessories button to select it, if it is not already 
darkened. 

The Corvus Spooler and the Corvus Oespooler will be listed in the box 
on the left of the menu. 

o Font 
Mover . @ Desk Accessory 

Corvus Despooler [Q ( 1.1)1>11 10 Corvus Spooler 
( 111'11101)1' 1 

to 
D/A 

on MGA ( Help 1 : 
2331Kfree 

( Close I ( Quit I; ( Open ... I 

5. Click the Open button on the right side of the screen. 
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6. Click the Drive button until the despooler's System volume is displayed. 

[ 

[ 

OFont 

Cl System Folder 

Mouer 

(g) ROB 

!:.; 1'1: I 

....... ~r.i.~.~ ..... ~ .. 
Open 

New 

[ancel 

7. Be sure that the System folder is darkened, then click Open to open the 
folder. 

If you have created a new System volume for the despooler according to 
the preceding instructions, there should only be one folder listed in the 
display. 

8. With the System folder open, be sure the system file is highlighted, then 
click the Open button. 
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If you have any files other than the System file in the despooler's 
System folder, then you will need to click on the name of the System 
file to select it. 

OFont 
Mouer 

c 
[ 

Ie System Folder I 
O:System·.: "-', '. :"". (g) ROB 

Driue 

~ 
~ 

[oncel 

10. Select the Corvus Despooler from the left hand side, then click the 
Copy button to copy it to the despooler's System volume. 

11. Click the Quit button to leave Font Dj A Mover and return to the 
desktop. 

12. Enter the Network Manager program and change the name of the 
volume owner to that of the actual des pooler station user. 

Now, you should make an automount snapshot for the despooling station. 
To do this, 

1. Pull down the Special menu and select Shutdown. 

2. Insert the despooler's Startup diskette. 

3. Log on as the despooler's user. 

4. Open Mount Manager and mount the user's System volume, as well as 
any other volumes that the user will be using regularly. 
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5. Pull down the Snapshot menu and select Take. 

6. Select the despooler's System volume, then click on Select Volume. 

7. Save the snapshot to the user's Startup diskette. 

8. Pull down the File menu and select Quit. 

Setting Up a Dedicated Non-user Despooling Station 

To set up a dedicated non-user despooling station, assign a name to the 
despooler and list it in the User table as a device-booting workstation. 
Then, make a Startup diskette and System volume for the workstation, and 
copy the foll,owing files to the System folder in the new System -volume: 

• System (version 3.2 or later) 
• Finder (version 5.3 or later) 
• OmniWriter 

Then, copy the following files to the System volume, but not into the System 
folder: 

Copy 

• Logon 
• OmniPrep = Pipes 
• Corvus Oespooler D j A 
• Corvus Spooler OJ A (optional) 

It is not necessary for the despooler to have the Corvus 
Spooler OJ A, but if you do add the Spooler OJ A, then 
you will be able to use the dedicated despooler to spool 
files. 

'. Corvus Modem or Printer Port 2.0 

to the despooler's Startup diskette. 

Your dedicated despooling station is now set up. 
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INITIALIZING THE PRINTER 

Having set up the despooling station, the next step is to initialize the 
printer. 

1. Turn on the Macintosh despooling station. 

2. When the desktop is completely drawn, turn on the printer. 

If you are using a LaserWriter (or compatible) printer on your network, 
allow it to complete its startup process before going any further .. 

3. Pull down the Apple Menu and select Corvus Despooler. 

" File Edit Uiew Special 

~ Coruus Omninet Despooler _ 

o Network Printer Despooler on 

@ LaserWriter 0 ImogeWriter 

Printer nome II!;fH;lIy;tM"I 

OK ( Cancel 

IlPillitilllill' l.d~I'rlJJritl'r 

u2.0 

i 
Trash 

4. Select the type of printer you have. 

5. Enter the printer name or accept the default. 

This name must be from one to eight letters or numbers in length. 

6. Click Network Despooler On. 

7. Click OK to complete the process. 

Your network printer is now ready for use. 
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Networking with Constellation III 

Constellation III with the Omninet network allows you to 

• Access remote computers and devices from your own workstation 
• Expand your storage capablity through the use of OmniDrives 
• Work on multiuser application files 
• Transfer files between computers 
• Perform more efficiently within your working environment. 

Constella tion is easy to learn and use. There are just a few things yo'u need 
to know to use your Constellation III network. 

Before you get started with Constellation III, however, you need at least the 
following items: 

II User Name 
II Startup diskette (to log your computer on to the network) 
II System volume (to store your system files) 
II Private volumes (as needed) 
III Public volume containing the following programs: 

Mount Manager 
File Transfer 
Pipes 
Logoff 
Any other shared programs or files 

If you do not have these items, contact your Network Manager. It is' his 
responsibility to provide them for you. 

In order to use the network effectively, you have to understand a few 
things about the way the network operates. In this chapter we will discuss 
how to use volumes (the way a network stores information), how to send 
files to print, and how to transfer files between users. 
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Volumes 

The OmniDrive on your Omninet network is a hard disk that can hold the 
equivalent of hundreds of regular Macintosh diskettes. Corvus divides the 
hard disk into units called volumes, each of which can hold as many as 
forty double-sided (800k) diskettes' worth of data. Your Network Manager 
will determine the actual size of the volumes when he sets them up for your 
use. 

On the Macintosh desktop, volumes are represented by icons depicting an 
OmniDrive. To gain access to a volume, you "Mount" it. The volume's icon 
will then be visible on the desktop, and your computer can read and write 
data to and from that volume. When you are finished, you "Unmount" the 
volume. 

VOLUME ACCESS 

There are two types of access to volumes: 

• Read-write (R/W) access allows you to view, change, save, delete, 
rename, and move files around, and rearrange the desktop in a 
volume. 

• Read-only (R/O) access allows you to view and copy the contents 
of a volume, but not change anything in it. 

In addition, any volume can have a passwdrd that permits access only to 
those who know the password. 

VOLUME TYPES 

There are four types of volumes on the system. 
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• Private volumes can be used only by the volume's owner, and he 
always has R/W access to them. Private volumes are for files that 
no one else will be using. 
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• Public volumes can be read and used by any user, unless the volume 
is password protected, but only the volume's owner can make 
modifications to the volume through RjW access. Public volumes 
are typically used to keep data that all network users need to share. 

• Controlled volumes allow RjW access by all users, unless the volume 
is password protected, but not at the same time. The first user to 
mount a controlled volume has RjW access to it; subsequently, all 
other users who mount the volume have read-only access. Once the 
first user unmounts the volume, another user can mount it with 
read-write access. This allows a variety of users to take turns 
looking at and writing to files. 

1'1 Uncontrolled volumes allow RjW access by several users at the same 
time. This permits multiple users to work with applications 
programs specifically designed to accept simultaneous input. These 
types of programs must be used with uncontrolled volumes. 
Programs that are not designed for multiuser applications should 
not be located in uncontrolled volumes, as unrestricted read-write 
access to single-user applications can result in loss of data. 

Mounting and Unmounting Volumes-

The Mount Manager Program 

You must mount volumes before you can work with them, and you can 
mount as many as six Corvus volumes at one time. The Mount Manager is 
the program you use to mount volumes. Initially, you can run the Mount 
Manager from your Startup diskette; but once your Network Manager has 
created a public volume with Mount Manager on it, you should run the 
program from that volume. Also, you can have your volumes mounted 
automatically each time you log on by using the Snapshot option, as 
explained later. 

MOUNTING VOLUMES 

1. Open the the Mount Manager program by double-clicking on the Mount 
Manager program icon. 
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Mount Manager will display all the volumes you can access. The Drive 
column shows you which drive each volume is on. The Access column 
shows you the volume type. If volume names are listed in boldface 
letters, they are already mounted. 

" File Snapshot Info Show 

Mount Manager: User JRNEL 

Uolumes Driue Rccess 
ADMIN DRIVEl Cant [Mount n:"o] 
BINKYS DRIVEl Ucnt 
DATABASE DRIVEl Priv 
MGR DRIVEl Priv (Mount n:"w) 
PUBLIC DRIVEl Publ 

( IJnMount ) 

2. Select a volume from the list. 

Use the indicator to move through the list'until you find the volume 
you want to mount, then click on the row to select the volume. 

3. Click either the Mount Read-Write or the Mount Read-Only button. 

Both options will not always be da-rk. If the volume you se.1ect is a 
public volume, for example, and you are not the owner, only the Mount 
Read-Only button will darken. 

4. Type the volume password (if you are prompted to do so), then click OK 
to mount the volume. 
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If the volume has a password, you will be prompted to enter it. If it 
doesn't, the volume will be mounted as soon as you click either the 
Mount Read-Write or Mount Read-Only button. 
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Volumes can also be mounted by double-clicking on the volume name in the 
list or by pressing return after the volume name is selected. Double-clicking 
a volume always mounts it with read-write access, if that option is 
available. 

To exit Mount Manager, pull down the File menu and select Launch (to go 
directly to another program) or Quit to return to the desktop. 

UNMOUNTING VOLUMES 

To unmount a volume and remove it from the Macintosh desktop, 

1. Open the Mount Manager program by double-clicking on the Mount 
Manager icon. 

2. Select a volume from the list by moving the cursor and clicking on the 
row of the volume you wish to unmount. 

3. Click the Unmount button. 

You can unmount any mounted volume except the one from which you are 
running the Mount Manager program. 

SNAPSHOTS 

Snapshots provide a method of automatically mounting volumes at the time 
you log on. The Mount Manager program allows you to select up to six 
volumes to be be mounted each time you run the Logon program. Taking a 
snapshot creates a special automount file that does all the mounting for you. 

To take a snapshot, 

1. Open the Mount Manager program by double-clicking the Mount 
Manager icon. 
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2. Select and mount the volumes you want mounted automatically each 
time you log on. 

You may select any volumes you wish, but your System volume must be 
one of them. 

3. Pull down the Snapshot menu and select "Take". 

A box asking you to select your System volume will be superimposed on 
the screen. 

" File Info Show 

Mount Monoger : User JRNEL 

Uolumes 

ADMIN 
BINKYS 
DATABASE 
MGR 

Driue 

DRIVEl 
DRIVEl 
DRIVEl 
DRIVEl 

Select Your System Uolume: 

MGR ' ~ 

PUBLIC 

Rccess 

Cant 
Ucnt 
Priv 
Priv 

[Mount BfO] 

Select UOIU~ nt 

(NO System ualume) 

( Concel SnopShot ) 

4. Select your System volume, then click Select Volume. 
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Your System volume contains your System folder with the System file 
and Finder in it. The Network Manager should have created one for 
you. You should only have one. 

When you click Select Volume, another screen asking for the location of 
your snapshot will appear. 

If you click the No System Volume button, the volumes will be mounted 
when you logon and the Startup diskette will be the System diskette. 
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5. Click the Drive button until your Startup diskette is listed. 

C File .. , • 'I' ,1_ Info Show 

Mount Manager: User JANEL 

Uolumes Driue Access 
ADMIN DRIVE 1 Cant IQj rVOn I'tll/O] 

I (g) NetMgr Startup I 
~ D ,JI\NH IQ (g) NetMgr St ... 

<JI 1.01,1011 

<JI Mount M!ll' [ Eject ) 
o System Folder [ Driue ) ~ 

10 
"-

Name of snapshot? [ saue~ 

I~IIJ~I!_ I ( Cancel l 

6. Save the file. 

Save the file under the default name (your user name) and save it on 
your Startup diskette. Do not save it on your System volume. The 
snapshot will work only if it is loaded on the Startup diskette. Use the 
drive button in the dialog box to select your Startup diskette. 

7. Pull down the File menu and select Quit to exit from Mount Manager 
and return to the desktop, or use Launch to move directly into another 
program. 

To test your new Startup diskette: 

1. Log off the system, then log on with your new Startup diskette. 

2. Enter your name (and password, if you have one). 

Your Startup diskette will be ejected and the volumes you chose to be 
mounted automatically will be mounted. In a few seconds, their icons 
will appear on the Macintosh desktop display. 
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You can also view your automount snapshot and the 
volumes you've selected' to automatically mount by 
pulling down the Snapshot menu and selecting the Look 
option. 

LAUNCH 

The Launch option is a convenient way of moving directly from one 
application to another without going to the desktop first. You can open any 
application in any mounted volume or inserted diskette using the Launch 
option. To use the Launch option, 

1. Pull down the File menu and select Launch. 

The window at the left in the Launch box contains a list of 
applications. All these applications are in the volume or diskette named 
above the window. 

C Snapshot Info Show 

Mount Manager: User JANEL 

Uolumes Driue 
ADMIN DRIVEl 

I=PUBlIC I 
<SI Pipes 
... File Transfer 

<SI logOff 
<SI Mount Mgr 

Access 
Cant 

=PUBlIC 

[ I: j(!< t 

[ Driue 

Open lQ 
Cancel J 

2. Click the Drive button to list the applications in a different mounted 
volume or inserted diskette. 
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The name of a different volume or diskette appears above the window 
that displays the applications in that volume. You can scan applications 
in all your mounted volumes and inserted diskettes by continuing to 
click Drive. 
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If you want to eject a diskette, click Eject when the name of the 
diskette in the drive is showing. You cannot eject a volume. 

When you see the application you want to open, double-click on its 
name to open it. Or you can first click on its name to select it and then 
click the Open button. Either method opens the application. 

Printing 

As a user on a network, you have two printing options: you can use a local 
printer or a network printer. Before you install your printer desk 
accessories, determine what kind of printing you are going to be doing. 

II If you are always going to be using a local printer and never 
printing on the network printer, you will not need the Corvus 
Spooler OJ A. 

a If you are always going to be using the network printer and never 
printing locally, you will not need the Apple Chooser OJ A. 

LOCAL PRINTING 

A local printer is one connected directly to your Macintosh. To print from 
a local printer, use the Apple Choose Desk Accesory. See your printer 
manual and appropriate Macintosh manuals for instructions on how to use 
the Chooser. 

NETWORK PRINTING 

When you print on a network printer, your file is sent (spooled) to a 
transfer area where it is temporarily stored, then despooled and printed. 
This means that you can move directly on to other tasks. You don't have to 
wait for your file to finish printing before you can use your computer 
again. 

To use a network printer, you must have the correct Corvus network 
software--a Desk Accessory called the Corvus Spooler. You need a second 
Desk Accessory (the Corvus Despooler) if your workstation is a despooling 
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station. If a printer connected to your Macintosh is designated as the 
network printer, your workstation will be a despooling station. You must 
use the Corvus Spooler Dj A to print on any network printer, even if it is 
connected directly to the Macintosh you are using. 

PRINTING LOCALLY AND ON THE NETWORK 

If you plan to do both both local and network printing, keep and use both 
the Chooser and Corvus Spooler desk accessories. 

If you usually print locally but want to print on the network printer, use 
the Chooser Dj A to select Omniwriter. The OmniWriter driver is identified 
by three stars above the LaserWriter icon. 

Untitled 

~ .. 1. •.. .I .. ' ... 1 ..•... I.2. •. 1 .•.. .I .• 1 ...•. ..I:::~ .. 1 .•.. L •... 1. • ..I1 ... 1 ..• L •... 1 •. I~: ... 1 ...• 1:; •. I .•. ..I° •... 1. •... L •. 1 ..• 1 
g) g) D to line';,/Tncl-I ~ ~ ~ ~-~~ I I 

o Chooser 

Turn Corvus Spool er DI A Onl 

I---

Click in the go away box in the upper right hand corner, then pull down 
the Apple menu, select Corvus Spooler, and be sure that there is an X in the 
box marked Network Printer Spooler On. 

7-12 Chapter 7 



Constellation III for the Macintosh 

Untilled 

~I .•... 1. 1.12• I .•. I,. L. I:~,L.",L." L. j,::t.l... "I.." I. ,I.:~"L. L.I. It~ , I , .".1. •.. L .1 
!d!d D61i',-,:i",,-I' ~~r===l ~-~~~ 

--_ [orllus Omninet Spooler ---

D Network Printer Spooler On 

(!) LaserWriter OlmageWriter 

Printer Name 11!;fB;!iiJ;-1 

lime Out IseC! LII_S ___ -----l 

OK ClIncel 

L'2.0 

If you have been printing on the network and want to print on your local 
printer, turn off the Corvus Spooler Dj A, then use the Chooser Dj A to 
select the printer driver as you would normally. 

You must use Chooser version 3.0 or earlier. Do not use 
Chooser version 3.1 or later, as the later versions are 
incompatible with the Corvus software. The System file 
on the Corvus Diagnostic diskette contains Chooser 
version 3.0. 

NETWORK DES POOLING STATION 

A despooling station is a workstation on the network that is connected 
directly to the network printer and provides a background task called 
despooling. Despooling essentially means directing the network printing 
traffic, which takes place with no interruption to the user who is at the 
despooling station. If your workstation is the network despooling station, 
you have two additional responsibilties: 

• You must be sure the Corvus Despooler Dj A is in your System file . 

.. You must turn on the Despooler D j A each time you reboot. 

To turn on the Corvus Despooler, 
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1. Turn on your Macintosh and wait until the desktop is completely drawn. 

2. Turn on the printer. If it's a LaserWriter, wait until it produces the 
startup page. 

3. Pull down the Apple Menu, then select the Corvus Despooler. 

A screen asking you to select the type of printer you have and asking 
for its name appears. 

* File Edit Uiew Speciol 

MGR I 
9 it.ms ..,,,..,v· ~~~n 

. ., 
__ Comus Omninet Despooler __ 

MGR 

Il Il o Network Printer Despooler on 
Syst.m ~ 

4 it.ms 
@ loserWriter o ImogeWriter IDlm1 

[ II!;fUi!iui-1 D Printer nome 
or: 

CorvusMod.mPo 
I- ( OK ) ( Concel ) 

( Ilpini tilllil.l~ I. il~Prl1Jri h~r ) 
u2.0 

!! I 
Mount Mgr Trash 

4. Select the type of printer that you will be using. 

LaserWriter and ImageWriter are the two choices. Select one by clicking 
on the button next to the one you want. The button will darken. 

5. Enter the printer name. 

The printer name default is LASERWR. Write down the printer name, 
and be sure that everyone who will be spooling files to that printer 
knows its name. 

6. Click the Network Printer Despooler On box. 

An X will appear in the box. 

7-14 Chapter 7 



Constella tion III for the Macintosh 

7. Click OK. 

If the printer is a LaserWriter, it will initialize. Clicking on the Cancel 
bu tton will cancel the en tire operation. 

SPOOLING A FILE TO THE PRINTER 

With the Spooler Dj A in your System file, you can send a file to print on 
the network printer. 

1. Pull down the Apple menu and select the Corvus Spooler D j A. 

The Spooler screen will appear. 

It File Edit Uiew Speciol 

MGR I 
9 items 735K in disk 2412K availabl. I 

T 1 MGR 

0 [ Comus Omninet Spooler - = 

System ~ 
4 items 

[gI Network Printer Spooler On 
PUBLIC 

[ 0 @ LoserWriter o ImogeWriter 
Dr-

CorvusModemP 
Printer Nome !1'MHui"'! I---

Time Out (sec) !15 ! 
( OK ) ( Concel ) 

~ 1J2.0 I 
un! Mgr Trosh 

2. Choose the printer type. 

Click either the LaserWriter or ImageWriter button. 

3. Click the box next to the Network Printer Spooler On. 

When the spooler function is turned on this box will have an X in it. 
Click the box if it is not already marked with an X. 
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4. Choose the printer name. 

Find out the name that has been given to the printer you want to use. 
If you click on the LaserWriter button, the default is LASERWR. 

s. Enter the value for time outs. 

When you send a file to the Pipes area, the computer does not 
automatically know when to terminate the print job. The time out tells 
the network printer driver to finish sending a file after a specified 
period of time has elapsed. If no data is received after the specified 
number of seconds, the network printer driver assumes there is no more 
data and closes the pipe so that the file can be printed. 

The default value for the time out is 15 seconds. A busy network may 
require more time to send a file and a longer time out may be required. 
However, if the time interval is set too long, a second file may be sent 
as part of the original file. In this case, two separate files would be 
printed as one. If the time interval is too short, the entire file may not 
be'sent. One file would then be printed in two separate pieces, and 
data might be lost. The default value (15 seconds) should prove 
effective in most cases. 

6. Click the OK button to complete your selections or Cancel to stop the 
transaction. 

Clicking "Cancel" will make no changes to the system. You must click 
OK to complete the selection. Then you can begin to print from within 
your application or from the desktop, just as you would normally. 

File Transfer 

The File Transfer program allows you to exchange files electronically with 
other users on the network. When you send a file using the File Transfer 
program, your file is sent to the transfer area. It is stored there until it is 
despooled by the workstation that is to receive it. The File Transfer 
program also allows you to exchange files between different types of 
computers--you can exchange files between Macintoshes and IBM PCs, for 
example. 
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DATA AND TEXT MODES 

The data mode sends or receives entire program files; the text mode sends or 
receives only the text files. Any file, text or program, can be sent through 
the network in its entirety from one Macintosh to another, or to a PC, and 
vice versa, using the data mode. However, not all files can be exchanged 
between a Macintosh and a non-Macintosh. 

Macintosh files have a particular structure that may not be readable by 
other computer types, but the text mode converts text files to ASCII files 
that can be read by all computers. Therefore, you will generally want to 
use the text mode when sending files between Mac and non-Mac computers. 
Some application programs, such as Word 3 and Excel, are available for both 
Mac and non-Mac machines. These programs offer the option of saving a 
file in a non-Mac format. If you are using such a program, you can send a 
file from a Mac to a non-Mac using the Data option. This will send the 
entire file, enhancements as well as text. 

SENDING FILES 

The Transfer File program should be in a public volume that your Network 
Manager has created for all network users to share. To send a file in the 
File Transfer program: 

1. Double-click the File Transfer program icon to open the program. 

A screen asking you to specify the mode and the name of the Pipe to 
which you want the file to be sent will appear. 

2. Choose the mode. 

Click either the Data or Text mode button. 

3. Enter the Pipe name. 

Give the pipe a unique name. The name of the pipe can be from one to 
eight letters or numbers long. ,Do not use "LASERWR" or "IMAGEWR" 
as pipe names, because they may already be used as the pipe names for 
the printers. 
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Entering the pipe name darkens the Send and Receive buttons. 

It file [<IiI 

rile Transfer 

Mode: @ Doto 0 TeHt 

Pipe: I DOCUMENT I 
( Receiue ... ) 

IWelcome to rile Tronsfer 

4. Click the Send button. 
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The screen will show the files that you have available to send. If you 
chose the Text option, only text-only files will be displayed. You can 
move between drives by clicking on the Drive button. Find the file to 
be sent and select it by clicking on its row. 

It File [<IiI 

D Omni Prep 
D OmniWriter 
q. DR Mouer 
D DeskTop, 
D DMM 
D JRNEL 
q. NetWork Mgr 
D Screen 0 
o Screens 

=MGR 

[je(1 

Driue 
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5. Click the Send button to send the file. 

A message reading "Sending file [XX]" will appear. The number of 
blocks being sent will also be displayed until the process is complete. 
When the file has been sent successfully, the screen will display a 
message informing you of this and telling you how many blocks were 
sent. The file has been sent to the Pipe you named, and another user 
can receive it. 

RECEIVING FILES 

To receive a file, double-click the File Transfer program icon' to open the 
program. 

1. Choose the mode. 

Click either on the Data or Text mode button. 

2. Enter. the Pipe name. 

Enter the name of the pipe to which the file was sent. Entering the 
pipe name darkens the Send and Receive buttons. 

3. Click the Receive button. 

A window will appear asking for a name under which to save the file. 
This will default to the name of the file sent. Use the Drive button to 
change drives, if necessary. 

If only one file was sent, the name the file was sent 
under will appear in the the box labeled, "Receive the 
file". If more than one file was sent, the name in the 
box may not be the first file sent. When files are sent to 
the transfer area, pipes are numbered based on the 
activity of the area as a whole. 

4. Type in the name of the file to save and click Receive. 
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5. Click the receive button. 

7-20 

The file will then be received. The number of data blocks being 
received will be displayed until the process is complete, at which time a 
message will be displayed telling you that there are no more Pipes with 
the name you specified. If more than one file has been spooled to the 
pipe you have just used, the Receive File message will reappear, asking 
you if you want to receive the next file in the queue. If you do, click 
Receive to repeat the process. If not, click Cancel. 

Clicking on the Cancel button in the receive box 
removes a pipe. If you click on the Cancel button to 
halt the transaction, you will remove the pipe. 
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Introduction 

The Diagnostic program contains tools that you can use to fix certain 
problems on an OmniDrive. It also allows you to customize your drive for 
special situations. This section outlines how a hard disk drive works and 
explains what the various utilities in the Diagnostic program can do. 

The OmniDrive 

A hard disk drive contains several aluminum disks, or platters, mounted like 
phonograph records on a central spindle. To the side is an actuator with a 
number of data heads attached to it, one for each side of each disk in the 
drive. Each head extends out over the surface of a disk like the tone arm 
of a record player, and reads and writes data on the disk. 

The data is stored concentric rings called tracks. Tracks are subdivided 
in to zones called sectors. The purpose of this organization is to provide 
coordinates for locating specific units of data on the tracks. These units 
are called blocks. On an OmniDrive, each block commonly stores about half 
a kilobyte of information. 

DRIVE INDICATOR LIGHTS 

The OmniDrive has three front panel lights labeled Fault, Busy, and Ready. 
These show the condi tion of the drive. The drive takes a minute or so to 
become ready. During this time the Fault and Ready lights will be lit, and 
the Busy light will flash. Then the Ready light will come on by itself, 
signifying that the drive is ready to respond to a command. 

If the Ready light doesn't come on after twenty seconds, reset the drive .by 
turning it off, waiting a minute, and then turning it on again. If the drive 
has been given a command and is in the process of responding to it, the 
Busy light will come on and flicker with the Ready light as data is 
transferred to and from the drive. The behavior of these lights taken in 
conjunction with other symptoms can help identify problems with the drive. 
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The Diagnostic Program 

The Diagnostic program contains a number of different utilities that allow 
you to analyze and correct problems with the OmniDrive. These utilities 
are on the Corvus Diagnostic diskette. To enter the Diagnostic program, 
you will need to insert the Diagnostic diskette, double-click on its icon, then 
double-click on the Diagnostic program icon. When you do this, a box 
listing information about your OmniDrive will appear on the screen. 

BAD TRACKS 

Sometimes a track has a bad sector, like a scratch on a phonograph record, 
and the heads can't read information stored there. This causes an error in 
reading or writing to any file stored on the bad sector. The remedy is to 
tell the drive to skip or "spare" the track containing the bad sector so it is 
no longer used. 

Media Check 

In order to find a bad track, you have to run a media check. A media 
check verifies the integrity of all the blocks on the drive. A media check 
performs a cyclical redundancy check (CRC) of the magnetic media on the 
drive platter surface. Any tracks reported as bad in a CRC test should be 
spared. To run a media check: 

In the Diagnostic program, 

1. Pull down the. Diagnostic menu and select the Media Check option. 
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A screen asking you to select the number of passes you would like the 
media check to make will appear. 
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2. Select the number of passes. 

The recommended number of passes is 3 to 5. 

* File ••. I I Seruers Mise Pipes 

Device type: OmniDrive at address 0 
SERVERO 
DRIVE I 
ROM version 23. drive switch 5 
Size: 22MB/O 
Firmware version: 
ODRV.l.7 -- CaNST II - 09/84 

01 PllSS 1 minute per poss 

02 posses [ Concel I 
@ 3 posses 

04 posses LEIrJ 
05 posses 

3. Click OK. 

You will be told that the media check is in progress and how long it 
will take to complete. During the time that the media check is being 
performed, the Busy light on your OmniDrive will be lit. When the 
media check is finished, the program will report whether or not any 
bad tracks were found. 

4. If there were no bad tracks, Click OK. 

If there are bad tracks, make a record of them. 

5. Either spare the tracks or press Cancel. 

Sparing a track moves data on the drive, and can result 
in data loss; thus, you should always back up your drive 
before sparing tracks. If you have already backed up 
the drive, you can spare the tracks. Otherwise, press 
cancel and read the next section, Sparing Tracks." 
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Sparing Tracks 

When a bad track is found, the drive must be told to skip that track when 
data is written to it. This process is known as "sparing" a track. 

Before a track is spared, make sure all the data on the drive are backed up. 

If a track is spared by mistake, delete it from the drive 
table immediately. 

The maximum number of tracks that can be spared will vary from drive to 
drive. If you spare the maximum number of tracks, contact Corvus 
Customer Service. To spare a track: 

In the Diagnostic program, 

1. Pull down the Diagnostic menu and select the Spare Tracks option. 

A menu will appear showing you tracks that have already been spared. 

C File •• ., , Sewers Misc Pipes 

Spored trocks : 

~ 
( Spore Truck ) 

(BPI1l11IJl> IrllI:l:) 

~ 
No trock(s) currently spored, 
36 more trock(s) moy be spored. 

( '>IlOP ) ( Concel ) 
Sewer SERUERO, Driue DRIUEI 

2. Click the Spare Track button. 

3. Specify the track to be spared. 

Enter the number of the track you want to spare. 
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4. Save the Spare Track table. 

Click the Save button. (Click Yes when asked if you want to continue.) 

Removing Tracks 

Generally, it is not advisable to remove a track from the spare track table. 
If you are instructed to remove a track from the table by Corvus Customer 
Service, select the Spare Tracks option, remove the track by clicking the 
Remove Track button and saving the table. 

Formatting a Drive 

The address of any track that has been spared because of a bad sector is 
recorded in the drive's spare track table. Over time, this table can become 
full. If this happens, you should contact Corvus Customer Service. They 
may advise you to format the drive to reduce the number of bad sectors, 
and consequently the number of tracks needing to be spared. . 

Ie' Formatting a drive will permanently remove all data on ill that drive. 

Formatting a drive sets up a grid-like control pattern on the disks to 
delineate where the blocks fall. A completely blank disk that is missing this 
control information cannot be read by the drive controller board. 
Reformatting a drive that has previously been formatted wipes out the 
original control information and replaces it with new control information. 

A sector may be bad because of a media defect in the platter itself. But a 
bad sector may also be caused by faulty control information. If this is the 
problem, laying down new control information may correct the condition. 
To format a drive: 
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In the Diagnostic program, 

1. Pull down the Server menu. 

The Select Server screen will appear. 

2. Select the Server you wish to format, then click the Select button. 

3. Pull down the Diagnostic menu and select the Format option. 

A warning telling you that all data on the drive will be destroyed by 
this procedure and asking you if you want to continue will be 
displayed. 

4. Click OK to continue. 

5. Format the drive. 

6. Reset the drive. 

Turn the drive off and then back on. 

UPDA TING FIRMWARE 

The spare tracks table is located in the firmware area of a drive. Also in 
this area are the active User/device table, the pipes pointer, and the 
controller code. The controller code, often called the firmware, translates 
between computers and the drive. It interprets computer commands so that 
the drive controller board can understand and act on them. You may wish 
to update firmware if it becomes damaged, or to upgrade the firmware with 
a newer version. 

If the current version of your firmware is faulty, your drive will be 
inoperable and the Fault light will remain lit. Replace the firmware and, if 
the problem persists, contact Corvus Customer Service. 
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To Update the Firmware: 

In the Diagnostics program, 

1. Pull down the Diagnostic menu and select the Update FW option. 

You will be asked if you want to update the firmware on the drive that 
is currently selected. 

2. Click OK to update the firmware. 

3. Reset the drive. 

Turn the OmniDrive off and then back on to reset it. 

4. Click OK. 

SEMAPHORES 

Semaphores are a tool for allowing multiple users on a network to use write 
access to the same files safely. When a specially designed multiuser
application locks a semaphore for a file, no one else can gain write access to 
that file until the semaphore is unlocked again. The file is therefore 
protected from being changed by two or more users simultaneously. 

An example of this technique can be found in your Constellation software. 
The Corvus Drive Management software uses a semaphore to protect the 
CORVUS volume, where the drive management tables and directory of 
volumes on a drive are stored. You update this volume any time you use 
the Network Manager to add, delete, or change a volume on the drive. 
Whenever you perform one of these operations, the CORVUS volume 
semaphore, named CR VSEMA4, locks for a second or so to keep other users 
out of the volume. 

It is possible, in unusual circumstances, such as a power 
failure, for a semaphore to become "stuck" in a locked 
position. If this should happen, unlock the semaphore 
using the Diagnostic diskette. 

You will not need to lock semaphores, unless directed to do so by Corvus 
Customer Service. Instructions on how to unlock and clear semaphores 
using the Diagnostic program follow. 
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Unlocking Semaphores 

To unlock a semaphore, in the Diagnostic program, 

1. Pull down the Diagnostic menu and select Semaphores. 

The semaphore list will appear, showing you all the currently locked 
sempaphores. 

2. Click the name of the semaphore you want to unlock. 

3. Click the Unlock button. 

The semaphore you selected will disappear from the table. 

4. Click OK. 

This quits the Semaphores option and returns you to the main level of 
the Diagnostic program. 

Clearing Semaphores 

Clearing semaphores unlocks all semaphores at once and removes their 
names from the list of locked semaphores. To clear semaphores, 

1. Pull down the Diagnostic menu and select Semaphores. 

The semaphore menu will appear. 

2. Click the Clear button. 

All semaphores in the table will disappear. 

3. Click the OK button to exit to the main Diagnostic desktop. 
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READ AFTER WRITE 

When this option is selected, the drive controller reads each sector on a disk 
after writing to it to verify that data is recorded correctly. The option is 
useful for protecting vital data, but using it slows program response time. 
Unless you have special concern about the integrity of your data, you 
should leave this option turned off. 

To turn on Read After Write, from the Diagnostic program, 

1. Pull down the Diagnostic menu and select Read After Write. 

2. Click the Read After Write button. 

3. Click OK. 

UNINITIALIZE PIPES 

When the transfer area of a drive is initialized, a pointer in the firmware is 
set to the pipes area's address. If you delete the pipes volume to remove the 
pipes area from the drive, you must also clear the pointer in the firmware 
using the Uninitialize Pipes option. Failure to clear the pointer could result 
in data loss. 

To uninitialize pipes in the Diagnostic program, 

1. Pull down the Pipes menu and select Uninitialize. 

You will be asked to confirm that you want to remove the pipes 
pointer. 

2. Click OK. 

The pipes volume is now unitialized. 
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PARKING HEADS 

Parking the heads moves them to an area on the disk where there isn't any 
data. This positions them where they cannot destroy information on the 
disk if the drive is dropped or jarred when being moved. You should 
always park the heads before shipping or transporting a drive. 

To park the heads, from the Diagnostic program, 

1. Pull down the Diagnostic menu and select the Park Heads option 

A message will appear telling you that parking the heads will end you 
communication with the drive. 

2. Click OK. 

3. Turn off the drive. 

EXERCISING HEADS 

You can exercise the heads to check for hard and soft errors on the drive. 
This provides information that may be useful to Corvus Customer Service, 
if you should need to call them about a problem with your drive. The 
Exercise Heads option is found in the Diagnostic menu. 

SPEED TEST 

The Speed test shows the rotational speed of the drive in revolutions per 
minute. Running the Speed Test provides information that may be useful to 
Corvus Customer Service, if you should need to call them about a problem 
with your drive. The Speed Test option is found in the Diagnostic menu. 
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Appendix A 

Updating an Existing Constellation III for Macintosh 

System to Release 2.0 

This appendix describes how to update an existing Constellation III network 
for Release 2.0. To update your network, you will need to do the following: 

• Back up volumes and convert from MFS to HFS, if desired. 
• Make new Startup diskettes and System volumes containing fresh 

copies of System 3.2 (or' later) and Finder 5.3 (or later) on them. 
• Add new versions of the Network Management software and delete 

old ones. 
II Add new Corvus Printing Desk Accessories to fresh copies of 

System. 

CONVERTING VOLUMES FROM MFS TO HFS 

Volumes on your current Omninet network are MFS volumes. With this 
release you have the option of converting them to HFS to take advantage of 
Apple's new HFS capabilties. 

it 
The conversion process erases any data in the volume. 

, Before converting from MFS to HFS you should first 
• back up any data you want to save. 

To convert a volume from MFS to HFS, 

1. Back up data you wish to save. 

2. Shut down your Macintosh, then boot up using the Corvus Diagnostic 
diskette. -

3. Use the new Mount Manager (from the Corvus User diskette) to mount 
any volumes you wish to convert. 

4. Select (but do not open) the volume to be modified. 

5. Pull down the Special menu. 
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6. Select the Erase Disk option. 

A box naming the volume to be erased and asking you to cancel or 
initialize the operation will be superimposed on the screen. 

7. Click the button marked Initialize. 

Once erased in this manner, the volume becomes an HFS volume. 

You can now l:llake new System volumes and Startup diskettes for your 
network. 

MAKING NEW STARTUP DISKETTES 

To update your network to Release 2.0 you must make new Startup diskettes 
for everyone on your network." You should make them all at this time. 

Follow the instructions in Chapter 4 for making Startup diskettes. Make 
sure you do not use copies of the System and Finder from your old Startup 
diskettes. Older versions of System and Finder will conflict with the new 
Constellation III software. Use fresh copies of System 3.2 (or later) and 
Finder 5.3 (or later) from your Apple System Tools diskette or from the 
Corvus Diagnostic diskette. 

ADDING NEW VERSIONS OF THE NETWORK MANAGEMENT 
SOFTWARE 

This release of the Constellation III software provides new versions of the 
following files: 

• Log On 
• Mount Manager 
• Network Manager 
• File Transfer 
• Corvus Modem Port 
• Corvus Printer Port 
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• Pipes 
• D/A's 
• Omni wri ter 
.0mniPrep 
• Logoff 
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You must replace older versions of these files with the 
latest releases. Failure to do so could result in serious 
network difficulties. 

To add the new files, 

1. Log on to your network with your new Startup diskette. 

2. Make sure the System folder in your System volume contains fresh 
copies of the following files: 

• System (3.2 or later) 
• Finder (5.3 or later) 

Also on your system volume, but not necessarily in a folder, you need: 

.. Font Dj A Mover 

3. Copy the following files from the User diskette into your System 
volume. 

EI Mount Manager 3.4 
II File Transfer 1.0 
• Logoff 3.1 

4. Copy the following file from the User diskette into the System folder in 
your System volume: 

m OmniWriter 

And for a despooling station, copy OmniPrep from the User diskette to 
the System volume, but not into the System folder. 

(When prompted to replace old files, click OK). 
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ADDING NEW VERSIONS OF THE PRINTING DESK ACCESSORIES 

This release of the Constellation III software provides new versions of the 
following desk accessories (0/ A's): 

• Corvus Spooler 
• Corvus Oespooler 

In order to print on the Omninet network, you must use these new versions 
of the Corvus printing desk accessories. 

You may not install these new 0/ A's on an old Corvus 
System file. Make a new Corvus System file. Simply 
deleting old Corvus printing 0/ As from an old Corvus 
System file and adding the new ones is not sufficient to 
guarantee printing on the Omninet network. 

To add new 0/ A's, 

1. While logged on, with your System volume in the upper right corner of 
the desktop, insert the User diskette. 

2. Open the User diskette and double-click on the Corvus D/ A 2.0 icon. 

This will execute the Font 0/ A Mover. 

3. Select Desk Accessories. 

You should see two files, the Corvus Spooler and the Corvus Oespooler, 
on the left side of the screen (under User diskette). 

4. Click the Open button on the right side. 

5. Use the Drive button to select your System volume. 

6. Open the System file in the System folder on the right side. 

There should not be any Corvus 0/ A's in your System file at this time. 

7. Copy the Corvus Spooler Desk Accessory from the User diskette to your 
System file. 
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8. If you are setting up the Network Despooling station, also copy the 
Corvus Despooler D/ A file from the User diskette to the System file. 

Your Constellation III for Macintosh software has now been updated for 
Release 2.0. 
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Appendix B 

Error Messages 

This appendix contains a list of common error and warning messages 
generated by the Corvus Constellation III software. Error messages may also 
be generated by the Apple Macintosh programs. For information about 
error messages not found in this appendix, check your Apple Macintosh 
manuals. 

Error messages are displayed on the screen with numbers. The error 
message provides a reference number for Corvus Customer Service, if you 
should need to call them. 

If you get an error message numbered 99, you have duplicate Omninet 
addresses on your network. The screen will display the standard system 
error message "Sorry, a system error occurred" when you attempt to boot up 
the system. Check all the addresses of the drives and computers on your 
network and change any duplicates to a unique address. 

The error messages are discussed on the following pages. Each message is 
given with a brief explanation and instructions on how to proceed. 

Cannot relocate CORVUS volume within the first 32 MB. 

When updating a drive's CORVUS volume, the Installer program 
relocates the existing CORVUS volume and makes it larger. The new 
size for the CORVUS volume will be 130 blocks plus the number of 
blocks of the existing CORVUS volume. The new CORVUS volume 
must reside within the first 32 Megabytes of the drive. You will have 
to delete a volume to make room within the first 32 Megabytes of disk 
space. 

Corvus volume too small for merge. 

Your attempt to merge user tables failed because your existing drive's 
CORVUS volume is too small. If you have not already updated the 
drive's CORVUS volume, do it now and then try again to merge user 
tables. If you have already updated the drive's CORVUS volume, call 
Corvus Customer Service. 
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Disk/Drive Unavailable for Update/Access 

You tried to update the CORVUS volume--add a volume, change a 
user's attributes, etc.--when the CORVUS volume semaphore, 
CRVSEMA4, was locked. Normally, the semaphore is locked only when 
a user is updating the CORUVS volume. In this case, the semaphore 
will be locked only temporarily. Try your operation again, after a few 
minutes' wait .. 

If the error message appears again, enter the Diagnostic program and 
use the Unlock Semaphore option. When prompted for the name of the 
semaphore to unlock, type CR VSEMA4. 

Drive must have a name. 

You tried to set up a new drive without specifying a drive name~ Type 
a name for the drive that is 10 characters or less. 

Drive or server name must be 10 characters or less. 

You entered a drive or server name that was more than 10 characters. 
Type a new drive or server name that is 10 characters or less. 

Drive Volume sequence error. 

While attempting to update your drive's CORVUS volume, the Installer 
program failed because the CORVUS volume was corrupted. ,Contact 
Corvus Customer Service for instructions on how to proceed. Make sure 
you have a current volume list in your Network Manager's notebook. 
This list will help you reconstruct the drive. 

Duplicate User/Device 

B-2 

The user or device that you are attempting to add already exists. Enter 
a new name for the user or device. 
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Duplicate Volume Name 

You've tried to add a volume with the same name as another volume 
already on the drive. Each volume must have a unique name. Type in 
a new name of 10 characters or less. 

File OmniPrep is not on the system volume. 

The file OmniPrep is not in your system volume, meaning that you will 
not be able to use the Restart LaserWriter button in the LaserWriter 
Despooler desk accessory. You will still be able to despool files. Copy 
the file OmniPrep to your system volume. 

Invalid Home Disk Server Name 

The home disk server name for a user or device is longer than 10 
characters. Enter a new home disk server name that is 10 characters or 
less. 

Invalid Host # 

You've tried to set up a Macintosh to perform a device boot, but the 
Omninet address specified was not in the range 0-63. Be sure you have 
the current Omninet address of the Macintosh. 

In valid Name 

You have given an invalid Drive Management name. Drive 
Management names must be 10 characters or less and must contain only 
letters, numbers, and periods. They are used to identify users, volumes, 
devices, servers, and drives. Enter a valid name. 

Invalid Password 

You've typed a password that is longer than eight characters. Type a 
new password that is eight characters or less. 
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Invalid Volume Length 

You've tried to add a custom volume that's too large to fit in the 
segment of unused space you've chosen. Specify a smaller volume size 
or choose a different space. 

Invalid Volume Name 

The volume being added, changed, or deleted is named incorrectly, the 
name is longer than 10 characters, or the volume is not on the current 
drive. 

Network User table size mismatch. 

The attempt to merge network user tables was halted because the 
Installer program found user tables of varying sizes on the network. 
All user tables must be the same size. Call Corvus Customer Service. 

No disk servers found on the network. 

The network has no active servers. Attach your drives to the network. 
If your drives are already attached, then make sure the drives are 
turned on, all cables are secure, and your Transporter is connected to 
the network. 

Passwords must be 8 characters or less. 

You entered a server or drive password that was more than eight 
characters. Type a new password that is eight characters or less. 

Pipes Volume Address Too High 

B-4 

The pipes volume must reside within the first 32,000 blocks of the 
drive. Clear an area large enough for your pipes volume within the 
first 32,000 blocks of your drive. Try again to create the pipes volume. 
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Sorry • . . That's the wrong password 

You entered the wrong server or drive password when entering the 
Network Manager mode. Type the correct s'erver or drive password. 

The Corvus Installer must be run from a floppy disk. 

You tried to run the Corvus Installer program from a volume on your 
drive. Run the program from the Corvus Installation disk. 

The inserted disk is not a system disk. 

The disk you inserted to be made into a Corvus Startup disk does not 
contain a System folder. Insert a disk that does contain a System 
folder. 

The selected drive is already set up. If you continue, all information on the 
drive will be destroyed. 

You are installing the Drive Management tables on a drive that has 
already been set up. All information on the drive will be destroyed'if 
you con tin ue. Make sure you have selected the proper drive and that 
you have saved all valuable information. :-

There must be more than one drive on the network to merge user tables. 

You tried to use the Merge network user tables option on a network 
that only has one drive. If you are adding a new drive to an existing 
network, make sure that you attach the new drive to the network before 
using this option. 

There are no servers with a Pipes area on the network. 

You have tried to use the pipes area when it does not exist yet. Follow 
the steps in Chapter 4 of this guide to create the pipes area. 
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There was an error copying the Logon program to the startup disk. 

The Logon program was not copied to your startup disk. You probably 
do not have enough free space on your disk. The Logon program 
requires 16K. Make sure your disk has at least 16K of free space, copy 
the Logon program on to your disk, and try again. 

Too many users for merge. 

Merging user tables on your network failed because the number of 
combined users exceeded the capacity of the network. The maximum 
number of users for an Omninet network is 512. Delete unnecessary 
users. 

Unexpected I/O error. 

There has been an error when the InstaJler program tried to either read 
from or write to your drive. Contact Corvus Cl.!stomer Service. 

Volume Not Found 

You have tried to change or delete a volume that is not on the current 
server and drive. Select the appropriate server and drive. 

Volume Owner Not Found 

B-6 

You've tried to assign ownership of a volume to a user whose name is 
not in the network user tables. Select a user that has already been 
created. 
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Appendix C 

Pinouts for Cables from the Macintosh to a LaserWriter 

Macintosh 512}( 
or 512}(E Signal Laser W ri ter(D B2 5) 

I 
2 
5 
7 
9 

Ground 
+5VDC 
TxD
DTR 
RxD-

I 
7 
3 
20 
2 

Macintosh Plus 
or SE Signal LaserWriter(DB25) 

3 
4 
5 
6 

All other signal pins are unused. 

TxD
Ground 
RxD
Ground 

5 
3 
9 
3 

II To use a LaserWriter with a Macintosh 512}( or 512}(E use a 
standard "Macintosh 512K to ImageWriter" cable . 

• To use a LaserWriter with a Macintosh Plus or Macintosh SE use a 
standard "Macintosh 512K to ImageWriter II" cable. 
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Appendix D 

Batch File Commands 

A batch file is a group of instructions that have been bundled together so 
that they can be processed at one time. Constellation III for Macintosh 
includes an option for processing batch files. The Batch option is ideal for 
environments such as schools, where large groups of new users must be 
managed on a regular basis. 

This appendix explains the various commands that can be used in 
Constellation III for Macintosh batch files. In the following explanations, 
the command keywords appear in bold letters. Required parameters appear 
in normal type and optional parameters appear in italics. Below is an 
example of the Add User command. 

Add User UserName\Password, OSType, HomeServer 

When entering these commands, make sure that you press IRETURNI after 
each command line entry. Also make sure that you follow the syntax 
exactly. Even if you do not enter a value for an optional parameter, you 
must still enter the comma following the parameter. 

To process a batch file, 

1. Create the batch file using MacWrite or any other text editor and save 
it as Text Only. 

2. Enter the Network Manager program and select the drive on which you 
sa ved the batch file. 

3. Pull down the Misc menu and select Batch. 

4. Click the drive button until the volume with your batch file is 
displayed. 

5. Open' the batch file. 

Opening the batch file will initiate processing. The batch file that is 
being processed will be displayed. A message will tell you the batch 
file processing is complete. 
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6. Click the go away box to clear the screen. 

In the CORVUS volume on each drive, there is a file called C3.Data that 
contains a list of the established values for the following parameters: 
BootType, DeviceType, OSType, and VolumeType. A value entered for one 
of these parameters must match one of the entries in the C3.Data file. 
There are two more parameters, Access and MacAccess, tha t have a range of 
values as well. The values for these parameters are built into the Data 
Management Module, a support file for the Network Manager program. Two 
tables at the end of this appendix list the values for each parameter. 

When making a batch file, you must use the Select commands to set the 
current server and drive. 

The commands on the following pages are explained in alphabetical order. 
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ADD ACCESS 

Description: 

Syntax: 

Parameters: 

Example: 

Constellation III for the Macintosh 

This command grants access privileges to the specified 
volume for the current user and the current server and 
drive. The current user is set with the Select User 
command. The current server and drive are set with 
the Select Drive and Select Disk commands. This 
command is only used for non-Macintosh volumes and 
users. 

Add Access VolumeName, Access, Unit 

Vol umeN arne is the volume name. 

Access is the type of access the current user will be 
granted to the volume. The access may either be read
write or read-only. If this parameter is omitted the 
default access type is read-only. 

Unit is the mount unit designator for the operating 
system. The value for this parameter is dictated by the 
mount type associated with the operating system. Unit 
can be a number (1-99), a letter (A-P), or a slot/drive. 
It can also be a dash (-) to indicate the volume is 
unmounted or an asterisk (*) to signal that the volume 
is the user's boot volume. If this parameter is omitted, 
the default is unmounted. 

Add Access IBMVOL, R W, E 
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ADD DEVICE 

Description: 

Syntax: 

Parameters: 

Example: 

D-4 

This command adds a device record to the 
NETWORK. USER table. 

Add Device DeviceName, OSType, HomeServer, 
DeviceType, Host#, Single 

DeviceName is the name of the network device to be 
added. The name can be a maximum of 10 characters. 

OSType is the boot operating system for the device. 

HomeServer is the name of the device's home disk 
server. 

DeviceType is the device's type description. When 
adding a computer to perform a device boot the device 
type must be Workstation. 

Host# is the Omninet address of the device. 

Single indicates that changes will be made only to the 
current server and drive. 

Add Device MacBoot, Mac, MacPubs, Workstation, 22, 
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Description: 

Syntax: 

Parameters: 

Example: 

Constella tion III for the Macintosh 

This command creates a new user record in the 
NETWORK.USER table. 

Add User UserName\Password, OSType, HomeServer, 
Single 

UserName\Password is the new user's name and 
password. The name can be a maximum of 10 
characters; the password can be a maximum of eight 
characters. 

OSType is the user's boot operating system. 

HomeServer is the name of the user's home disk server. 
A home disk server is used at boot time to locate 
operating system information stored in a boot volume. 
If you are creating a Macintosh user, any server on the 
network may be designated as the home disk server· 
because the Macintosh boots from a disk instead of a 
volume. If this parameter is omitted, the current 
server is used as the home disk server. 

Single indicates that changes will be made only to the 
current server and drive. 

Add User Mike\BMW, Mac, , 
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ADD VOLUME 

Description: 

Syntax: 

Parameters: 

D-6 

This command creates a volume on the server and 
drive designated by the Select Drive and Select Disk 
commands. 

The Add Volume command does not format the volume 
for use with its designated operating system. To 
format non-Macintosh volumes, use the Format Volume 
command. To format Macintosh volumes, you must use 
the Clear option in the Volume mode of the Network 
Manager program. 

Add Volume VolumeName, VolumeType, Length, 
Address, Access, Owner\Password, MacAccess 

VolumeName is the volume name. The name can be up 
to 10 characters. 

VolumeType is the volume type description for the new 
volume. 

Length is the size of the volume in 512k byte blocks. 
When creating Macintosh volumes, you must indicate 
the size of the volume in blocks. You cannot specify 
volume size by typing a size such as extra-large. 

Address is the starting block address of the volume. 
This is checked along with the length to make sure 
volumes do not overlap. If this parameter is omitted, 
the volume will be assigned the lowest address of 
available disk space. 

Access is the global access designation for the volume. 
A value should be entered for this parameter only 
when creating a non-Macintosh volume. Global access 
always takes precedence over any of the user's 
individual access rights as well as the type of access set 
with the Add Access batch command. If this parameter 
is omitted, the default access will be read-only. 
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Owner\Password is the owner and password of the 
volume. These parameters should be used only when 
creating Macintosh volumes. The owner must be set to 
an existing user's name. The password is optional and 
can be up to eight characters. 

MacAccess is the volume access type for Macintosh 
volumes. See the table at the end of this appendix for 
the access values. 

Add Volume MACVOL1, Mac, 1600, , , Greg\GBS, Pu 
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CHANGE ACCESS 

Description: 

Syntax: 

Parameters: 

Example: 

Comment: 

D-8 

This command allows modifications to be made to the 
current user's access rights to a volume. 

Change Access VolumeName, Access, Unit 

VolumeName is the name of the volume for which 
access rights will be modified. 

Access is the user's new access rights to the volume. 

Unit is mount unit designator for the new operating 
system. 

Change Access VOL2, ,6 

This command is only for non-Macintosh volumes. 
When using this command you must first specify a user 
with the Select User command. 
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CHANGE DEVICE 

Description: 

Syntax: 

Parameters: 

Example: 
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This command allows modi fica tions to be made to a 
network device's record. 

Change Device DeviceName, OSType, HomeServer, 
DeviceType, Host#, Single 

DeviceName is the name of the current device. 

OS Type is the device's new boot operating system. 

HomeServer is the device's new home disk sever. 

DeviceTy pe is a new type description for the current 
device. 

Host# is the device's new Omninet address. 

Single indicates that changes will be made only to the 
current server and drive. 

Change Device MacBoot, , , , 24, 
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CHANGE USER 

Description: 

Syntax: 

Parameters: 

Example: 

D-10 

This command allows modifications to be made to a 
network user's record. Only those parameters which 
are supplied cause changes to the User's record. 

Change User UserName\Password, OSType, HomeServer, 
Single 

UserName\Password is the name of the user whose 
attributes will be changed. The user's password can be 
changed, but the user's name cannot be altered. 

OSType is the user's new boot operating system. 

HomeServer is user's new home disk server. 

Single indicates that changes will be made only to the 
current server and drive. 

Change User Joe \JDS, , , 
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CHANGE VOLUME 

Description: 

Syntax: 

Parameters: 

Example: 
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This command allows modi fica tions to be made to 
volume attributes. Changes to a volume do not affect 
its logical format or record. 

Change Volume VolumeName, NewName, VolumeType, 
Access, Owner\Password, MacAccess 

VolumeName is the name of the volume to be 
modified. 

NewName is the new name for the volume. 

VolumeTy pe is the new volume type for the volume. 

Access is the new global access for the volume. You 
can only change this parameter when working with 
non-Macintosh volumes. 

Owner\Password is the new owner and password for the 
volume. You can only change these parameters when 
the current volume is a Macintosh volume. 

MacAccess is the new access type for a Macintosh 
volume. This parameter can only be modified when 
using a Macintosh volume. 

Change Volume MACVOL1, , , , , Co 
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DELETE ACCESS 

Description: 

Syntax: 

Parameter: 

Example: 

D-12 

This command is only for non-Macintosh volumes. 
When using this command you must first specify a user 
with the Select User command. 

Delete Access Vol umeN arne 

VolumeName is the name of the volume that will be 
removed from the current user's list of accessible 
volumes. 

Delete Access VOLI 
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Description: 

Syntax: 

Parameters: 

Example: 
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This command deletes all associated records for a 
network device. 

Delete Device DeviceName, Single 

DeviceName is the name of the device to be deleted. 

Single indicates that changes will be made only to the 
current server and drive. 

Delete Device MacBoot, 
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DELETE USER 

Description: 

Syntax: 

Parameters: 

Example: 

0-14 

This command deletes all associ a ted records for a 
network user. 

Delete User UserName, Single 

UserName is the name of the user to be deleted. 

Single indicates that changes will be made only to the 
current server and drive. 

Delete User Bill, 
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DELETE VOLUME 

Description: 

Syntax: 

Parameter: 

Example: 
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This command deletes all associated records for a 
network device. 

Delete" Volume VolumeName 

VolumeName is the name of the volume to be deleted. 

Delete Volume NOTES 
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FORMAT VOLUME 

Description: 

Syntax: 

Parameters: 

D-16 

Use this command only to format non-Macintosh 
volumes. To format Macintosh volumes after creating 
them with the Add Volume batch command, use the 
Clear option in the Volume mode. 

Format Volume VolumeName ParmA, ParmB, no zero 

VolumeName is the name of the volume to be 
formatted. 

ParmA, ParmB,. . . are the optional parameters that 
may be specified to override the default values. 

For UCSD volumes, one parameter may be specified. 
This parameter determines the number of files in the 
directory as well as the directory size. The range for 
the parameter is 1-77. If omitted, the default is 77. 

F or MS-DOS vol urnes, three parameters maybe 
specified--cluster size, reserved sectors, and number of 
directory entries. All three parameters are optional 
and independent of each other. If you do not enter 
new values for any of the parameters the default 
values will be implemented. The default values are as 
follows: 

Volume Size = N Default Cluster 
(Blocks) Size 

N<= 2,000 

2,000 <N < = 16,000 

16,000 <N < = 32,000 

N>32,000 

Directory entries = 256 
Reserved sectors = 1 

4 

8 

16 

32 
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For CP 1M volumes, four parameters may be specified-
block allocation size, number of directory entries, 
sectors per track, and number of reserved sectors. The 
default values for the omitted parameters are 

Volume Size = N Default Block 
(Blocks) Size 

N<2,OOO 2 

2,000 <N < = 8,000 4 

N =>8,000 8 

No. directory en tries = 
(Block Allocation Size * 1024)/32 

Sectors per track = 64 

Reserved sectors = 0 

Nozero signifies that the volume directory should not 
be formatted. Only the information for the Corvus 
volume header is written. 

Format Volume FINANCES, , , 16, 
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PIPE 

Description: 

Syntax: 

Parameters: 

Examples: 

D-18 

There are three pipe commands. The commands close a 
pipe, purge a pipe, and initialize the pipes area. 

Pipe Function, ParmA 

Function 

Close 

Purge 

Initialize 

Pipe Close, Pipe3 
Pipe Purge, PipeS 
Pipe Initialize, PIPES 

ParmA 

Pipe# 

Pipe# 

VolumeName 
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SELECT 

Description: 

Syntax: 

Parameters: 

Examples: 

Comments: 
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The Select Disk and Select Drive commands are used to 
set the current server and drive. Use the Select User 
command to select the user when managing volume 
access for non-Macintosh users. 

Select Keyword= Name\Password 

Keyword Name 

Disk ServerName 

Drive DriveName 

User UserName 

Select Disk= MKTG\MK 
Select Drive= MACPUBS\PUB 
Select U ser= Tom 

Password 

ServerPassword 

DrivePassword 

These commands should be used at the beginning of 
your batch file. Note that when a password is given 
for a server or a drive, Constellation III will remember 
the passwords. Thus the user may switch between 
various servers and drives without reentering 
passwords. 
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SEMAPHORE 

Description: 

Syntax: 

Parameters: 

Examples: 

D-20 

There are three sempahore commands. The commands 
can lock a semaphore, unlock a semaphore, and 
initialize the semaphore table. 

Semaphore Function, ParmA 

Function ParmA 

Lock SemaphoreName 
: 

Unlock Index# 

Initialize 

Semaphore Lock, MBLock 
Semaphore Unlock, 2 
Semaphore Initialize 
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Parameter Value Table 

The table below shows the parameters and the list of valid values for each 
parameter. This table is stored in the C3.Data file in the CORVUS volume. 

BootType DeviceType OSType VolumeType 

Apple2 Apple2 A2CP/M A2S0S 

Apple3 Apple3 A2DOS3.3 AFS 

Atari-800 Atari800 A2Pascai Atari 

Companion Bank A2Runtime Cndimage 

Concept Boot-Device A3S0S CPM 

Concept2 Comm-Server Atari DOS3.3 

DEC-Rainbow Commodore-Pet C21V.0 Image 

IBM Companion CCOS Invimage 

LSI-11 Concept-Plus CP/M Mac 

Macintosh Corvus-Concept CP/M-68 MSDOS 

Nec-PC8000 DEC-Rainbow CP/M-86 New80 

PET IBM/PC/XT Mac NewDos 

Printer-Server LSI-11 MSDOS PET 

Sony-SMC-7086 Mirror-Server NCIIV.O ProDos 

TI-Pro NEC-PC8000 New80 Reserved 

TRS-80-Mod1 Omni-Drive NewDos RSX11 

TRS-80-Mod3 Print-Server Pet RT11 

Xerox820 TI-Professional ProDos UCSD 

Z-100 TRS-80-Mod1 RSX11 UNIX 

Zenith-H89 TRS-80-Mod2 SoftechlVO 

Workstation UCSDII 

Xerox Unix3 

Z-100 Unix5 

Zenith-H89 
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The values for the parameters Access and MacAccess are shown below. The 
values for MacAccess are the first two letters of the desired volume type. 
For example, Pr stands for Private, Pu stands for Public, etc. 

Access MacAccess 

NA PUB 
RO PR 
RW CO 

UN 
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Appendix E 

Using Constellation III with Non-Corvus Drives 

Constellation III for Macintosh and the Omninet network may be used with 
non-Corvus drives. Familiarity with ResEdit (resource editor from Apple) 
is essential. 

There are three major methods of linking to hard drives: 

II Automatic boot, such as used with Hyperdrive and Apple HD20 

• Floppy boot, such as the Corvus configuration 

• Program link, a program that links the hard drive and the 
Macintosh. 

Apple's HD20 is categorized as an auto-booting hard 
drive even when booting from floppy on a Macintosh 
512K, since the system used is the one found on the 
HD20. 

The following instructions refer to a "Corvus boot diskette". This should be 
a User diskette configured with Corvus's INIT resource for either the 
Modem or Printer port. Before continuing, set up the hard disk according 
to the manufacturer's instructions. 

AUTOMATIC BOOT METHOD 

MFS (System 2.0, Finder 4.1) 

Using ResEdit, copy OmniDriver (lD=II) and Omnilnit (ID=10) from the 
Corvus boot diskette to the local hard drive's system. 

Copy Logon to the hard drive, but do not set it as Startup--you may not 
always wish to log on to the Corvus network. When you wish to use the 
Corvus drive, run Logon and enter your name and password as usual. Then 
run Mount Manager to access the volumes. 
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Each time you boot, be sure the Transporter is connected. If it is not 
connected, the Macintosh will hang at the Welcome screen. This is because 
the Corvus INIT resource attempts to communicate with the card at boot 
time. 

If at any time you wish to boot your local drive without a Transporter, you 
will have to remove the INIT resource from the System file. 

HFS (System 3.1.1+, Finder S.x) 

For HFS volumes, you can use the same procedure as above, or take 
advantage of a new feature of Apple's System. 

At startup time, System now searches for files that have the file type INIT. 
To use this, use ResEdit to create a new file in the System folder and copy 
OmniDriver (10=11) and OmniInit (10=10) to this file. Set the file type to 
INIT. The creator type is not important. This file will be opened at startup 
time. If you do not wish to use Omninet, then change file type from INIT 
to four spaces. 

The advantages to using this method are that 

• It's easier to deactivate the Omninet link . 
• You do not have to reinstall the Corvus driver to upgrade Apple's 

system. 

After booting your local drive, you should run Logon and Mount Manager 
in the normal fashion. This procedure will allow you to use HFS on 
OmniDrives, allowing you to mix MFS and HFS volumes. To format an 
OmniDrive volume as HFS, simply click on the volume, select Erase Disk 
from the Special menu, then click Initialize in the dialog box. . 

FLOPPY BOOT 

The only difference between this method and the Automatic booting method 
is that the system modifications are made on your boot diskette instead of 
on your hard drive. 
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MFS (System 2.0, Finder 4.1) 

Use ResEdit to copy OmniDriver (ID=II) and Omnilnit (10=10) to the 
System file on your boot diskette. Make sure that the driver and IN IT 
resources do not clash with items already in the System file. Renumber the 
files, if necessary, so that their numbers are unique. 

HFS (System 3.1.1+, Finder S.x) 

For HFS volumes, follow the above procedure for MFS volumes; or you can 
create an INIT file and store it in the same folder as the System file. 

The biggest difference with the new System is that there is a separate INIT 
file, and so there can be no ID clashes. Follow the instructions for 
Automatic booting, creating a new file that should be stored in the System 
fold .... r on the boot diskette. 

PROGRAM LINK 

When using a linking program, simply boot the Corvus diskette, then run the 
program that links you to the hard drive. 
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